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Foreword

I can’t see the point in the theatre. All that sex and
violence. I get enough of that at home. Apart from the
sex, of course.
—Tony Robinson as Baldrick, Blackadder
Who Brings the Sex?
“Make it look real.” That would seem to be the mandate
of the visual effects artist. Spielberg called and he wants
the world to believe, if only for 90 minutes, that dinosaurs
are alive and breathing on an island off the coast of South
America. Your job: Make them look real. Right?
Wrong.
I am about to tell you, the visual effects artist, the most
important thing you’ll ever learn in this business: Making
those velociraptors (or vampires or alien robots or bursting dams) “look real” is absolutely not what you should be
concerned with when creating a visual effects shot.
Movies are not reality. The reason we love them is that they
present us with a heightened, idealized version of reality.
Familiar ideas—say, a couple having an argument—but
turned up to 11: The argument takes place on the observation deck of the Empire State Building, both he and she
are perfectly backlit by the sun (even though they’re facing
each other), which is at the exact same just-about-to-set
golden-hour position for the entire 10-minute conversation. The couple is really, really charming and impossibly
good looking—in fact, one of them is Meg Ryan. Before
the surgery. Oh, and music is playing.
What’s real about that? Nothing at all—and we love it.
Do you think director Alejandro Amenábar took Javier
Aguirresarobe, cinematographer on The Others, aside and
said, “Whatever you do, be sure to make Nicole Kidman
look real?” Heck no. Directors say this kind of stuff to their
DPs: “Make her look like a statue.” “Make him look bulletproof.” “Make her look like she’s sculpted out of ice.”
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Did It Feel Just Like It Should?
Let’s roll back to Jurassic Park. Remember how terrific the
T-rex looked when she stepped out of the paddock? Man,
she looked good.
She looked good.
The realism of that moment certainly did come in part
from the hard work of Industrial Light and Magic’s fledgling computer graphics department, which developed
groundbreaking technologies to bring that T-rex to life.
But mostly, that T-rex felt real because she looked good.
She was wet. It was dark. She had a big old Dean Cundey
blue rim light on her coming from nowhere. In truth, you
could barely see her.
But you sure could hear her. Do you think a T-rex
approaching on muddy earth would really sound like the
first notes of a new THX trailer? Do you think Spielberg
ever sat with sound designer Gary Rydstrom and said,
“Let’s go out of our way to make sure the footstep sounds
are authentic?” No, he said, “Make that mofo sound like
the Titanic just rear-ended the Hollywood Bowl” (may or
may not be a direct quote).
It’s the sound designer’s job to create a soundscape for a
movie that’s emotionally true. They make things feel right
even if they skip over the facts in the process. Move a gun
half an inch and it sounds like a shotgun being cocked. Get
hung up on? Instant dial tone. Modern computer displaying something on the screen? Of course there should be
the sound of an IBM dot-matrix printer from 1978.
Sound designers don’t bring facts. They bring the sex. So
do cinematographers, makeup artists, wardrobe stylists,
composers, set designers, casting directors, and even the
practical effects department.
And yet somehow, we in the visual effects industry are
often forbidden from bringing the sex. Our clients pigeonhole us into the role of the prop maker: Build me a T-rex,
and it better look real. But when it comes time to put that
T-rex on screen, we are also the cinematographer (with
our CG lights), the makeup artist (with our “wet look”
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shader), and the practical effects crew (with our rain). And
although he may forget to speak with us in the same flowery terms that he used with Dean on set, Steven wants us to
make sure that T-rex looks like a T-rex should in a movie.
Not just good—impossibly good. Unrealistically blue-rimlight-outa-nowhere good. Sexy good.
Have you ever argued with a client over aspects of an
effects shot that were immutable facts? For example, you
may have a client who inexplicably requested a little less
motion blur on a shot, or who told you “just a little slower”
for an object after you calculated its exact rate of fall? Do
you ever get frustrated with clients who try to art-direct
reality in this way?
Well, stop it.
Your client is a director, and it’s their job to art-direct reality. It’s not their job to know (or suggest) the various ways
that it may or may not be possible to selectively reduce
motion blur, but it is their job to feel it in their gut that
somehow this particular moment should feel “crisper” than
normal film reality. And you know what else? It’s your job
to predict that they might want this and even propose it.
In fact, you’d better have this conversation early, so you
can shoot the plate with a 45-degree shutter that both
the actors and the T-rex might have a quarter the normal
motion blur.
Was It Good for You?
The sad reality is that we, the visual effects industry,
pigeonhole ourselves by being overly preoccupied with
reality. We have no one to blame but ourselves. No one else
on the film set does this. If you keep coming back to your
client with defenses such as “That’s how it would really
look” or “That’s how fast it would really fall,” then not
only are you going to get in some arguments that you will
lose, but you’re actually setting back our entire industry by
perpetuating the image of visual effects artists as blind to
the importance of the sex. On the set, after take one of the
spent brass shell falling to the ground, the DP would turn
to the director and say, “That felt a bit fast. Want me to
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do one at 48 frames?” And the director would say yes, and
they’d shoot it, and then months later the editor would
choose take three, which they shot at 72 frames per second
“just in case.” That’s the filmmaking process, and when you
take on the task of creating that same shot in CG, you need
to represent, emulate, and embody that entire process.
You’re the DP, both lighting the shot and determining that
it might look better overcranked. You’re the editor, confirming that choice in the context of the cut. And until you
show it to your client, you’re the director, making sure this
moment feels right in all of its glorious unreality.
The problem is that the damage is already done. The
client has worked with enough effects people who have
willingly resigned themselves to not bringing the sex that
they now view all of us as geeks with computers rather
than fellow filmmakers. So when you attempt to break our
self-imposed mold and bring the sex to your client, you
will face an uphill battle. But here’s some advice to ease
the process: Do it without asking. I once had a client who
would pick apart every little detail of a matte painting,
laying down accusations of “This doesn’t look real!”—until
we color corrected the shot cool, steely blue with warm
highlights. Then all the talk of realism went away, and the
shot got oohs and aahs.
Your client reacts to your work emotionally, but they critique technically. When they see your shot, they react with
their gut. It’s great, it’s getting better, but there’s still something not right. What they should do is stop there and let
you figure out what’s not right, but instead, they somehow
feel the need to analyze their gut reaction and turn it into
action items: “That highlight is too hot” or “The shadows
under that left foot look too dark.” In fact, it would be better if they focused on vocalizing their gut reactions: “The
shot feels a bit lifeless,” or “The animation feels too heavy
somehow.” Leave the technical details to the pros.
You may think that those are the worst kind of comments, but they are the best. I’ve seen crews whine on
about “vague” client comments like “give the shot more
oomf.” But trust me, this is exactly the comment you want.
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Because clients are like customers at a restaurant, and
you are the chef. The client probably wants to believe that
“more oomf” translates into something really sophisticated,
like volumetric renderings or level-set fluid dynamics, in
the same way that a patron at a restaurant would hope that
a critique like “this dish needs more flavor” would send
the chef into a tailspin of exotic ingredients and techniques. Your client would never admit (or suggest on their
own) that “oomf” is usually some combination of “cheap
tricks” such as camera shake, a lens flare or two, and possibly some God rays—just like the diner would rather not
know that their request for “more flavor” will probably be
addressed with butter, salt, and possibly MSG.
The MSG analogy is the best: Deep down, you want to go
to a Chinese restaurant that uses a little MSG but doesn’t
admit it. You want the cheap tricks because they work, but
you’d rather not think about it. Your client wants you to
use camera shake and lens flares, but without telling them.
They’d never admit that those cheap tricks “make” a shot,
so let them off the hook and do those things without being
asked. They’ll silently thank you for it. Bringing the sex is
all about cheap tricks.
Lights On or Off?
There are some visual effects supervisors who pride
themselves on being sticklers for detail. This is like being
an architect whose specialty is nails. I have bad news for
the “Pixel F*ckers,” as this type are known: Every shot will
always have something wrong with it. There will forever be
something more you could add, some shortcoming that
could be addressed. What makes a visual effects supervisor
good at their job is knowing which of the infinitely possible tweaks are important. Anyone can nitpick. A good
supe focuses the crew’s efforts on the parts of the shot that
impact the audience most. And this is always the sex. Audiences don’t care about matte lines or mismatched black
levels, soft elements or variations in grain. If they did, they
wouldn’t have been able to enjoy Blade Runner or Back to the
Future or that one Star Wars movie—what was it called? Oh
yeah: Star Wars. Audiences only care about the sex.
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On a recent film I was struggling with a shot that was just
kind of sitting there. It had been shot as a pickup, and it
needed some help fitting into the sequence that had been
shot months earlier. I added a layer of smoke to technically match the surrounding shots. Still, the shot died on
the screen. Finally, I asked my compositor to softly darken
down the right half of the shot by a full stop, placing half
the plate along with our CG element in a subtle shadow.
Boom, the shot sang.
What I did was, strictly speaking, the job of the cinematographer, or perhaps the colorist. The colorist, the person
who designs the color grading for a film, is the ultimate
bringer of the sex. And color correction is the ultimate
cheap trick. There’s nothing fancy about what a Da Vinci
2K or an Autodesk Lustre does with color. But what a good
colorist does with those basic controls is bring heaping,
dripping loads of sex to the party. The problem is—and
I mean the single biggest problem facing our industry
today—the colorist gets their hands on a visual effects shot
only after it has already been approved. In other words, the
film industry is currently shooting itself in the foot (we, the
visual effects artists, being that foot) by insisting that our
work be approved in a sexless environment. This is about
the stupidest thing ever, and until the industry works this
out, you need to fight back by taking on some of the role
of the colorist as you finalize your shots, just like we did
when we made those matte paintings darker and bluer with
warm highlights.
Filmmaking is a battleground between those who bring the
sex and those who don’t. The non-sex-bringing engineers
at Panavision struggle to keep their lenses from flaring,
while ever-sexy cinematographers fight over a limited stock
of 30-year-old anamorphic lenses because they love the
flares. I’ve seen DPs extol the unflinching sharpness of a
priceless Panavision lens right before adding a smear of
nose grease (yes, the stuff on your nose) to the rear element to soften up the image to taste. Right now this battle
is being waged on every film in production between the
visual effects department and the colorists of the world.
I’ve heard effects artists lament that after all their hard
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work making something look real, a colorist then comes
along and “wonks out the color.” In truth, all that colorist
did was bring the sex that the visual effects should have
been starting to provide on their own. If what the colorist
did to your shot surprised you, then you weren’t thinking
enough about what makes a movie a movie.
In Your Hands
You’re holding a book on visual effects compositing in
Adobe After Effects. There are those who question the
validity of such a thing. Some perpetuate a stigma that
After Effects is for low-end TV work and graphics only. To
do “real” effects work, you should use a program such as
Nuke or Shake. Those techy, powerful applications are
good for getting shots to look technically correct, but they
do not do much to help you sex them up. After Effects may
not be on par with Nuke and Shake in the tech department, but it beats them handily in providing a creative
environment to experiment, create, and reinvent a shot.
In that way it’s much more akin to the highly respected
Autodesk Flame and Inferno systems—it gives you a broad
set of tools to design a shot, and has enough horsepower
for you to finish it, too.
After Effects is the best tool to master if you want to focus
on the creative aspects of visual effects compositing. That’s
why this book is unique. Mark’s given you the good stuff
here, both the nitty-gritty details as well as the aerial view
of extracting professional results from an application that’s
as maligned as it is loved. No other book combines real
production experience with a deep understanding of the
fundamentals, aimed at the most popular compositing
package on the planet.
Bring It
One of the great matte painters of our day once told me
that he spent only the first few years of his career struggling to make his work look real, but that he’ll spend the
rest of his life learning new ways of making his work look
good. It’s taken me years of effects supervising, commercial directing, photography, wandering the halls of
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museums, and waking up with hangovers after too much
really good wine to fully comprehend the importance of
those words. I can tell you that it was only after this particular matte painter made this conscious choice to focus
on making things look good, instead of simply real, that
he skyrocketed from a new hire at ILM to one of their top
talents. Personally, it’s only after I learned to bring the sex
that I graduated from visual effects supervising to become
a professional director.
So who brings the sex? The answer is simple: The people
who care about it. Those who understand the glorious
unreality of film and their place in the process of creating
it. Be the effects artist who breaks the mold and thinks
about the story more than the bit depth. Help turn the
tide of self-inflicted prejudice that keeps us relegated to
creating boring reality instead of glorious cinema. Secretly
slip your client a cocktail of dirty tricks and fry it in more
butter than they’d ever use at home.
Bring the sex.
Stu Maschwitz
San Francisco, October 2008
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Introduction

If you aren’t fired with enthusiasm, you will be fired—
with enthusiasm.
—Vince Lombardi
Why This Book?
This book is about creating visual effects. Specifically, it
dives into the art and science of assembling disparate elements so that they appear as part of a single, believable
scene. When people ask me what exactly the book is about,
I tell them that it shows artists how to use a computer to
assemble a shot that doesn’t look as if it was assembled, just
photographed. It also hints at how to make an ordinary
shot extraordinary without destroying the viewer’s willing
suspension of disbelief.
The subject matter in this book focuses beyond the
obvious—and what is well documented elsewhere—and
deep into core visual effects topics. We look closely at
features such as color correction, keying, tracking, and
roto that are only touched on by other books about After
Effects while leaving tools more dedicated to motion
graphics (such as Text and Shape layers) largely alone. It’s
not that those tools aren’t a powerful part of After Effects;
it’s just that they literally don’t fit in this book.
As author, I do not shy away from opinions, even those
that deviate from the official line. These opinions and
techniques—which have been refined through actual work
in production at a few of the finest visual effects facilities
in the world—are valid not only for such high-end productions, but really anywhere you are compositing a visual
effect. Where applicable, the reasoning behind using
one technique over another is provided. I aim to make
you not a better button-pusher, but a more effective artist
and technician.
Visual effects companies are typically protective of trade
secrets, reflexively treating all production information as
proprietary. Once you work on a major project, however,
you will soon discover that even the most complex shot is
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made up largely of repeatable techniques and practices.
The art is in how the results are applied, combined, and
customized, and what is added (or taken away). Visual
effects artists, meanwhile, can be downright open and
friendly about sharing discoveries, knowing that it’s about
the artistry, not a clever bag of tricks.
Each shot is unique, and yet each relies on techniques that
are tried and true. This book offers you as many of the
techniques as possible so that you can focus on the unique
properties of each shot. There’s not much here in the way
of step-by-step instructions—it’s more important for you to
grasp how things work so that you can repurpose insights
for your individual shot.
This is not a book for beginners. Although the first section
is designed to make sure that you are making optimal use
of the software, it’s not an effective primer on After Effects
in particular or digital video in general. If you’re new to
After Effects, first spend some time with its excellent documentation or check out one of the many books available to
help beginners learn the application.
On the other hand, if you’re comfortable with Photoshop
and familiar with the visual effects process—which is likely
if you’ve picked up this book—try diving into the redesigned Chapter 1 and let me know how it goes.

This book’s technical editor, Todd
Kopriva, maintains an excellent blog called After Effects
Region of Interest at Adobe,
and he has assembled and
maintained a page of resources
for beginners titled “Getting
Started with After Effects.”
Visit http://blogs.adobe.com/
toddkopriva/2010/01/gettingstarted-with-after-eff.html.

Organization of This Book and What’s New
Although each chapter has been refined and updated, After
Effects Studio Techniques is organized into three sections, like
each previous edition.
.. Section I, “Working Foundations,” is about After Effects
and how to make the most of its user interface. This
is not a list of each menu and button but a shortcut to
being a power user.
If you’re an advanced user, don’t skip this section. It’s
virtually guaranteed to contain valuable information
that you don’t already know, and it has been freshened
up with new data and figures pertaining to new features.
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.. Section II, “Effects Compositing Essentials,” is about
the fundamentals of effects compositing. Color matching, keying, rotoscoping, and motion tracking are the
essentials, plus there’s a chapter on the camera and
3D along with another on the expressions used to
generate animated data with connections, logic, and
math. The final chapter in this section introduces you
to 32-bpc linear compositing and high dynamic range
imaging pipelines.
This section is the true heart of the book. This edition
contains dramatic rewrites of Chapters 7 through 9 due
to new rotoscoping, tracking, and 3D features added to
the application.
.. Section III, “Creative Explorations,” is about actual
shots you are likely to re-create—the bread-and-butter
techniques every effects artist needs to know. Some
of these examples are timeless, but you will also find
information about color grading with Adobe SpeedGrade, a powerful tool in every complete Creative
Cloud installation.
In all cases, instead of leading you step-by-step through a
single example, the goal is to explain the fundamentals
of how things work. You will then be able to put these
techniques to use on your own shot rather than relying
on a paint-by-numbers approach. Although each shot is
unique, all of them can be grouped together as effectively
the same in fundamental ways.

Artistry
While working on the first edition of this book I would
ride my bicycle home up the hill out of the Presidio where
the beautiful Orphanage facility was located. As I rode,
I thought about what people really needed to know in
order to move their work to the level of a visual-effects pro.
Sometimes it was very late at night, when raccoons and
skunks would cross my path. When I wasn’t worrying about
them, here’s what I came up with:
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.. Break it down. Talented but inexperienced students
learn how the software works but are not used to
analyzing a shot or sequence and breaking it down into
manageable, comprehensible steps. This is a book filled
with those steps.
.. Get reference. You can’t re-create what you can’t clearly
see. Too many of us skip this step and end up making
boring, generic choices. Nature is never boring, and if it
appears that way, you’re not looking at it closely enough.
.. Simplify. To paraphrase Einstein, the optimum solution
is as simple as possible, but no simpler.
.. Learn to take criticism rather than expect perfection.
My former colleague Paul Topolos, now in the art
department at Pixar, used to say, “Recognizing flaws
in your work doesn’t mean you’re a bad artist. It only
means you have taste.” To err is human, to cut yourself
a break and keep going, divine.
This book reflects what I learned working at the best
studios, and even if you’re not currently working at one of
them, this is how collaboration, criticism, and perseverance
will be your teachers.

Compositing in After Effects
There’s a good reason that Nuke, a node-based
compositing application from The Foundry, has almost
uniformly become the compositing application of choice at
feature film visual effects studios around the world. Nuke
is designed for exactly what those artists need—and only
what they need. In some areas, mostly the native handling
of 3D effects such as camera projection, stereo, and deep
compositing, Nuke is clearly ahead of After Effects. In
other areas, such as animation and type handling, After
Effects has the edge. For compositing fundamentals, the
two applications are equally valid, but operations that are
simple in Nuke can be complicated in After Effects, and
vice versa. Despite the impression that Nuke has taken
over, when you move beyond feature films, After Effects is

All compositing applications
are, at root, nodal, as you can
glimpse in the seldom-used
Flowchart view.
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the ubiquitous champion. They’re both awesome tools, but
the important takeaway is that Nuke is specialized, whereas
After Effects targets a broader set of users.
The following are some of the features that streamline
After Effects for the generalist and animator (and which,
paradoxically, can complicate workflows that are more
straightforward for video-effects compositing in Nuke):
.. Render order is established in the Timeline and via
nested compositions that consist of layers, not nodes.
After Effects has Flowchart view, but you don’t create
your composition there the way you would with a tree/
node interface.
.. Transforms, effects, and masks are embedded in every
layer. They render in a fixed order.
.. After Effects has a persistent concept of an alpha
channel in addition to the three color channels. The
alpha channel is always treated as if it is straight (never
premultiplied) once an image has been imported and
“interpreted,” as the application terms it.
.. An After Effects project is not a “script,” although there
are add-ons, in particular the script pt_OpenSesame,
that leverage script-like capabilities for After Effects.
.. Temporal and spatial settings tend to be fixed and
absolute in After Effects because it is composition- and
Timeline-based. This is a boon to projects that involve
complex timing and animation, but it can snare users
who aren’t used to it and suddenly find pre-comps that
end prematurely, are cropped, or don’t scale gracefully.
Best practices to avoid this are detailed in Chapter 4.
This book attempts to shed light on these and other
areas of After Effects that are not explicitly dealt with in
its user interface or documentation. After Effects spares
you details that a casual user might never need to know
about but that, as a professional user, you must understand
thoroughly. This book is here to help.
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Example Files
The example files that can be downloaded to use with this
book provide a variety of helpful resources for the After
Effects artist; many are provided by friends and colleagues
(thanks!).
Scripting Chapter: Jeff Almasol’s scripting chapter is
now an appendix and is found on your Account page
on Peachpit.com. This highly accessible resource on this
complicated and much-feared topic walks you through
three scripts, each of which builds upon the complexity
of the previous. Scripting provides the ability to create
incredibly useful extensions to After Effects to eliminate
tedious tasks. Several of these are included in the scripts
folder online as exclusives to this book.
A few useful and free third-party scripts mentioned
throughout the book are included as well. For more of
these, see the script links PDF in the scripts folder online.
JavaScript Guide: To focus on more advanced and applied
topics in the print edition, Dan Ebberts kicked JavaScript
fundamentals to a special JavaScript addendum, also
included as a PDF. This is, in many ways, the missing
manual for the After Effects implementation of JavaScript.
It omits all the useless Web-only scripting commands
found in the best available books and extends beyond the
material in After Effects help.
Special-Purpose Topics: Certain sections that appeared
in the print version of previous editions have been moved
online as PDF files. The tools and techniques are still valid,
but the material on topics such as ray-tracing, stereo tools,
morphing, warping, and color management is able to
stand on its own to make way for new features that had
to be integrated more directly into the rest of the book.
Footage: You’ll also find HD footage you can use to
experiment on and practice your techniques. There
are dozens of example files to help you deconstruct the
techniques described.
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How to Download the Files
If you have comments or
questions you’d like to share
with the author, please email
them to aestudiotechniques@
gmail.com.

You can download all of the files at once or pick and
choose among them. To access them, follow these steps:
1. Go to www.peachpit.com/redeem and enter the code

found at the back of your book.
2. If you do not have a Peachpit.com account, you will

be prompted to create one.
3. The downloadable files will be listed under the

Lesson & Update Files tab on your Account page.
4. Click the links for the files you want to download

to your computer.

The Bottom Line
It’s not about the tools. They are merely the means for
the skilled talented artist—you—to apply the hard work
required to inspire an audience—them—with results. By
thoroughly understanding the tools, you can learn to think
with them, and in so doing, forget about them as they
become second nature. This book will help.
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Optimize Projects

Build a system that even a fool can use and only a fool
will want to use it.
—George Bernard Shaw

Optimize Projects

T

his chapter examines in close detail how image data
flows through an After Effects project. It’s full of the
information you need to help you make the most of
After Effects.
Sometimes, like a master chef—you can prep items and
consider them “done” before the guests are in the restaurant and it’s time to cook the meal. At other times, like a
programmer, you must isolate and debug elements of a
project, creating controlled tests when necessary to understand how things are working. This chapter provides the
technical knowledge to allow the artistry to shine.

Work with Multiple Comps and Projects
A modestly complicated shot can entail thousands of
individual edits and decisions, and it’s easy to lose track
of assets when projects get complicated. This section
demonstrates
.. how and why to work with a project template
.. how to organize a complex, multiple-composition
pipeline
.. shortcuts to help maintain orientation within the
project as a whole
Precomposing is the action of
selecting a set of layers in a master
composition and assigning it to a
new subcomp, which becomes a
layer in the master comp. Closely
related to this is composition
nesting, the act of placing one
already created composition inside
of another.
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These tips are especially useful if you’re someone who
understands compositing but sometimes finds After Effects
disorienting.
Precomping and Composition Nesting
Precomposing is often regarded as the bane of After Effects,
because vital information is hidden from the current
comp’s Timeline in a nested comp. Artists may sometimes

I: Working Foundations

let a composition become unwieldy, with dozens of layers,
rather than bite the bullet and send a set of those layers
into a precomp. Yet precomping is both an effective way
to organize the timeline and a key to problem solving and
optimization in After Effects. Motion graphics comps can
involve the animation and coordination of hundreds of
animated elements. In a visual effects context, however,
if your VFX composition has more than 20 or so layers,
you’re doing precomping wrong, making your work way
less efficient overall.
Typically, precomping is done by selecting layers of a
composition to group together, and choosing Precompose
from the Layer menu (Ctrl+Shift+C/Cmd+Shift+C). Two
options appear (the second option is grayed out if multiple
layers have been selected): to leave attributes (effects,
transforms, masks, paint, blending modes) in place, or
transfer them into the new composition.
Why Precomp?
Precomping prevents a composition from containing too
many layers to manage in one timeline, and it also adds a
few other advantages. You can

A good VFX composition has no
more than a couple dozen layers,
maximum, and usually no more
than half that. Motion graphics
comps are different, because they
can involve coordinating the motion of dozens or even hundreds of
elements together.

Pre-compose by Jeff Almasol
(http://aescripts.com/
rd-pre-compose/) displays a dialog
to precomp one or more layers,
just like the regular After Effects
dialog, but adds the ability to trim
the precomp to the selected layer’s
duration, including trim handles.

.. Reuse a set of elements.
.. Fix render order problems. For example, masks are
always applied before effects in a given layer, but a
precomp can contain an effect so that the mask in the
master comp follows that effect in the render order.
.. Organize a project by grouping interrelated elements.
.. Specify an element or set of layers as completed (and
even pre-render them, as discussed later in this chapter).
Many After Effects artists are already comfortable with the
idea of precomping but miss that last point. As you read
through this, think about the advantages of considering an
element finished, even if only for the time being.
The Project Panel: Think of It as a File System
How do you like to organize your system—tidy folders for
everything or files strewn across the desktop? Personally,
I’m most content with a project that is well organized, even

Cache Work Area in Background
One reward for effectively using precomping
is the ability to then save the entire precomp
to the disk cache for immediate playback. This
happens automatically when you preview the
master sequence containing the precomp in
question, but you can also select the precomp in
the Project panel or open its timeline and choose
Composition > Cache Work Area in Background
to make After Effects immediately pre-render it in
the background. As explained later in the chapter,
the resulting cache remains available even if the
project is reopened at a later time, provided it is
reopened on the same system.
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if I’m the only one likely to work on it. When sharing with
others, however, good organization becomes essential.
The Project panel mirrors your file system (whether it’s
Explorer or Finder), and keeping it well organized and
tidy can clarify your thought process regarding the project.
I know, I know, eat your vegetables, and clean your room.
Imagine that the person next opening your project is you,
but with a case of amnesia—actually, that basically is you
after a sufficient period of time.
Figure 4.1 shows a couple of typical project templates
containing multiple compositions to create one final shot,
although these could certainly be adapted for a group of
similar shots or a sequence. When you need to return to a
project over the course of days or weeks, this level of organization can be a lifesaver.
Here are some ideas to help you create your own comp
template:
.. Create folders, such as Source, Precomps, and
Reference, to group specific types of elements.
.. Use numbering to reflect comp and sequence order so
that it’s easy to see the order in the Project panel.
.. Create a unique Final Output comp that has the format
and length of the final shot, particularly if the format
is at all different from what you’re using for work
(because it’s scaled, cropped, or uses a different frame
rate or color profile).
Figure 4.1 A complex project, such
as a shot for a feature film, might be
generically organized (top) to include
numbering that reflects pipeline order
and multiple output comps with
no actual edits, just the necessary
settings. At minimum (bottom), you
should have Source and Precomps
folders, as well as a Reference folder, to
keep project contents tidy.
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.. Use guide layers and comments as needed to help artists set up the comp (Figure 4.2).
.. Organize Source folders for all footage, categorized as
is most logical for your project.
Figure 4.2 Here is a series of non
rendering guide layers to define
action areas and color.
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.. Place each source footage clip into a precomp, so that
changes to source footage—where it is replaced for
some reason—are easier to handle without causing
some sort of train wreck.
The basic organization of master comp, source comp,
and render comp seems useful on a shot of just about any
complexity, but your template can include a lot more than
that: custom expressions, camera rigs, color management
settings, and recurring effects setups.
Manage Multiple Comps from the Timeline
Ever had that “where am I?” feeling when you’re working
with a series of nested comps? That’s where Mini-Flowchart,
or Miniflow, comes in. Simply press the Tab key with the
Timeline panel displayed to enable it; alternatively, you can
Miniflow button.
click the
Miniflow (Figure 4.3) shows only the nearest neighbor
comps, but click on the flow arrows at either end and you
navigate up or down one level in the hierarchy. Click on
any arrows or items in between the ends and that level is
brought forward. You’re even free to close all compositions
(Ctrl+Alt+W/Cmd+Opt+W), and then reopen only the
ones you need using this feature.

What about cases where you want to coordinate work in a
subcomp while seeing the result in the master comp? The
Lock icon
at the upper left of the Composition viewer
lets you keep that Composition viewer forward while you
open another composition’s Timeline panel and close its
view panel. Lock the master comp and double-click a nested
comp to open its Timeline panel; as you make adjustments,
you see the result directly in the master comp.
Ctrl+Alt+Shift+N (Cmd+Opt+Shift+N) creates two
Composition viewers side by side, and locks one of them,
for any artist with ample screen real estate who wants the
best of both worlds.

The 04_comp_templates folder
and project in the example files
contain relevant example comps.

Arrange Project Items into Folders
(http://aescripts.com/arrangeproject-items-into-folders/) looks
for project items with a matching
prefix and groups them together
in a folder. Load Project or Template at Startup (http://aescripts.
com/load-project-at-startup/)
loads a project or template each
time you start After Effects—
this can really help if you need
several people in a studio to follow
a certain organizational style. Both
scripts are by Lloyd Alvarez.

Figure 4.3 By default, the comp
order is shown flowing right to left.
The reason for this is probably that if
you open subcomps from a master
comp, the tabs open to the right;
however, you may want to choose
Flow Left to Right in Miniflow’s panel
menu instead.

If nothing else, a locked, untouchable Final Output comp prevents
losing a render to an incorrectly
set work area (because you were
editing it for RAM previews).
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To locate a comp in the Project panel, you can
The script preCompToLayerDur.jsx
from Dan Ebberts (found with
the example scripts) starts a
precomped layer at frame 1 even
if the layer to be precomped is
trimmed to a later time.

The Always Preview This View
lets you work entirely
toggle
in a precomp but switch automatically to the master comp (if this is
on in that comp) when previewing.

.. select an item in the Project panel; click the caret to see
where the item is used, along with the number of times,
if any, the item is used in a comp (Figure 4.4)

Figure 4.4 Click the caret next to the total number of times
an item is used to see a list of where it is used.

.. context-click an item in the Project panel and choose
Reveal in Composition; choose a composition and that
comp is opened with the item selected
.. context-click a layer in the timeline and choose Reveal
Layer Source in Project to highlight the item in the
Project panel
.. context-click in the empty area of a timeline and
choose Reveal Composition in Project to highlight that
comp in the Project panel (Figure 4.5)
.. type the name of the comp in the Project panel
search field

Figure 4.5 Find the empty area
below the layers in the timeline and
context-click; you can reveal the
current comp in the Project panel.

You may already know that a
double-click opens a nested comp,
and Alt–double-click (Opt–
double-click) reveals it in the
Layer viewer. How this functions
varies according to which tool
is active and specific settings in
Preference > General.
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Ways to Break the Pipeline
Precomping solves problems, but it can also create
problems—or at least inconveniences. Here are a few ways
that render order can go wrong:
.. Some but not all properties are to be precomped, but
others must stay in the master comp: With precomping
it’s all or nothing, leaving you to rearrange properties
individually.
.. Un-nesting: Changed your mind? Restoring precomped
layers to a parent composition is a manual (and thus
error-prone) process, due to the difficulty of maintaining proper dependencies between the two (for example,
if the nested comp has also been scaled, rotated,
and retimed).
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.. 3D nesting: Do the layers being precomped include
blending modes or 3D layers, cameras, or lights?
Their behavior changes depending on the Collapse
Transformations setting in downstream comps
(detailed in the next section).
.. Comp settings nesting: Is there motion blur, frame
blending, or vector artwork in the subcomp? Switches
in the master composition affect their behavior, as do
settings on each nested layer, and this relationship
changes depending on whether Collapse Transformations
is toggled on.
.. Layer timing (duration, In and Out points, frame rate)
and dimensions can differ from the master comp:
When this is unintentional, mishaps happen: Layers
end too soon or are cropped inside the overall frame,
or keyframes in the precomp fall between those of the
master, wreaking havoc on tracking data, for example.

True Comp Duplicator
(http://aescripts.com/
true-comp- duplicator/) was
created by Brennan Chapman to
address the biggest bugbear of
working with nested comps in
After Effects: In a node-based app,
you can duplicate an entire nested
tree and all of the components
are unique, but duplicate a comp
in After Effects and its subcomps
are the same as in the source.
This script can reside in a panel
ready to create an entire new
hierarchy—highly recommended.

.. Duplicating a comp that contains subcomps: The comp
is new and completely independent, but the nested
comps are not (see Tip on this page).
No wonder people avoid precomping. But there is hope if
you recognize any difficulty and know what to do, so that
inconveniences don’t turn into deal-breakers.
Boundaries of Time and Space
Each composition in After Effects contains its own fixed
timing and pixel dimensions. This adds flexibility for
animation but if anything reduces it for compositing. Most
other compositing applications (such as Nuke) have no
built-in concept of frame dimensions or timing and assume
that the elements match the plate, as is often the case in
visual effects work.
Therefore it is helpful to take precautions:
.. Make source compositions longer than the shot is ever
anticipated to be, so that if it changes, timing is not
inadvertently truncated.
.. Enable Collapse Transformations to allow the nested
composition to ignore its boundaries (Figure 4.6).

Figure 4.6 The nested comp has a
blue background and the leg of the
letter “p” extends outside its boundar
ies (top); a simple quick fix is to enable
Collapse Transformations, and the
boundaries of the nested comp are
ignored (bottom).
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.. Add the Grow Bounds effect if Collapse Transformations
isn’t an option (see the “Grow Bounds” sidebar on
page 109).
Collapse Transformations is the most difficult of these to
get your head around, so here is a closer look.
Collapse Transformations
In After Effects, when a comp is nested in another comp,
effectively becoming a layer, the ordinary behavior is for
the nested comp to be rendered completely before the
layer can be adjusted in any form in the master comp.

The 04_collapse_transformations
folder and project contain relevant
example comps.

Annoyed to find sequences
importing at the wrong frame
rate? Change the default Sequence
Footage Frames per Second under
Preferences > Import.

However, there are exceptions. Keyframe interpolations,
frame blending, and motion blur are all affected by the
settings of the master comp—they use its frame rate, and
thus keyframe timing (which can become tricky; see the
next section). 3D position data and blending modes, on
the other hand, are not passed through unless Collapse
Transformations is enabled. Enable the toggle and it is almost
as if the precomposed layers reside in the master comp—
except that any 3D camera or lighting in the subcomp is
overridden by the camera and lights in the master comp.
Any layer with Collapse Transformations enabled loses access
to blending modes—those in the subcomp take precedence
(and you can’t set two blending modes to one layer, obviously). Now here comes the trickiest part: Apply any effect
to the layer (even Levels with the neutral defaults, which
doesn’t affect the look of the layer) and you force After
Effects to render the collapsed layer, making blending
modes operable. It is now what the Adobe developers call
a parenthesized comp. Such a nested comp is both collapsed
and not: You can apply a blending mode, but 3D data is
passed through (Figure 4.7).
So, if you need to collapse transformations but retain 3D
data, apply any effect—even one of the Expression Controls
effects that don’t by themselves do anything—to parenthesize the comp.
Nested Time
After Effects is not rigid about time, but digital video—
whether source or output—definitely is. You can freely
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Figure 4.7 You’re not supposed to be able to apply blending modes to ray-traced and other 3D scenes. You can
precomp such a scene and enable Collapse Transformations so that all of its ray-traced 3D qualities are passed
through, but you still can’t apply a blending mode such as Add (shown here). However, if you add a simple effect,
such as Levels, unadjusted, transformations and shading are still passed through—occasionally a handy trick.

mix and change frame rates among compositions without
changing the timing, as has been shown. However, because
your source clips always have a very specific rate, pay close
attention when you
.. import an image sequence
.. create a new composition
.. mix comps with different frame rates
In the first two cases, watch out for careless errors. But
you might actually want to maintain specific frame rates
in subcomps, in which case you must set them deliberately
on the Advanced tab of the Composition Settings dialog,
as follows.

Grow Bounds
Sometimes, enabling Collapse Transformations
is not desirable—for example, if you set up 3D
layers with a camera in a subcomp and don’t want
their position to be changed by a camera in the
master comp. The Grow Bounds effect overcomes
one specific (and fairly rare) problem (in which the
embedded layer is too small for an applied effect),
but it is also useful in cases where other effects
create a comp boundary that leads visual data to
appear cropped.

Advanced Composition Settings
In addition to the Motion Blur settings covered in detail
in Chapter 8, Composition Settings > Advanced contains
two toggles that influence how time and space are handled
when one composition is nested into another.
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The Posterize Time effect will
force any layer to the specified
frame rate.

Preserve Frame Rate maintains the frame rate of the
composition wherever it goes—into another composition
with a different frame rate setting or into the Render
Queue with a specific, alternate frame rate set there (as
was mentioned in Chapter 1, it can be done). So if a simple
animation cycle looks right at 4 frames per second (fps),
it won’t be frame blended across the higher frame rate,
but will preserve the look of 4 fps.
Preserve Resolution When Nested controls what is called
concatenation. Typically, if an element is scaled down in a
composition that is then nested into another comp and
scaled back up, the two operations are treated as one, so
that no data loss occurs via quantization. This is usually a
good thing. If the data in the subcomp is to appear pixelated,
as if it were scaled up from a lower-resolution element, this
toggle preserves the chunky pixel look.

Special Case: Adjustment and Guide Layers
Two special types of layers, adjustment and guide layers,
offer extra benefits that might not be immediately apparent.
Adjustment Layers

Figure 4.8 The highlighted column
includes toggle switches, indicat
ing an adjustment layer. Any layer
can be toggled, but the typical way
to set it is to create a unique layer.
An adjustment layer created under
Layer > New > A
 djustment Layer (or
via the shortcuts) is a white, compsized solid.

From a nodal point of view, adjustment layers are a way
of saying “at this point in the compositing process, I want
these effects applied to everything that has already rendered.” Because render order is not readily apparent in
After Effects until you learn how it works, adjustment layers
can seem trickier than they are.
The adjustment layer is invisible, but its effects are applied to
all layers below it. It is a fundamentally simple feature with
many uses. To create one, context-click in an empty area of
the Timeline panel, and choose New > Adjustment Layer
(Ctrl+Alt+Y/Cmd+Opt+Y) (Figure 4.8).
Adjustment layers allow you to apply effects to an entire
composition without precomping it. That by itself is pretty
cool, but there’s more:
.. Move the adjustment layer down the stack and any
layers above it are unaffected, because the render order
in After Effects goes from the lowest layer upward.
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.. Shorten the layer and the effects appear only on frames
within the adjustment layer’s In/Out points.
.. Use Opacity to attenuate (basically, “dial back”) any
effect; most of them work naturally this way. Many
effects do not include such a direct control, even when
it makes perfect sense to “dial it back 50%,” which you
can do by setting Opacity to 50%.

Alpha channel effects change the
alphas of the layers below, not of
the adjustment layer.

.. Apply a matte to an adjustment layer to hold out the
effects to a specific area of the underlying image.
.. Add a blending mode and the adjustment layer is
first applied and then blended back into the result
(Figure 4.9).
It’s a good idea 99 percent of the time to make sure that
an adjustment layer remains 2D, and you will most often
also want it to be the size and length of the comp, as when
applied. You may not ever choose to move, rotate, or scale
an adjustment layer in 2D or 3D, but it is easily possible to
do so accidentally. If you enlarge the composition, resize
the adjustment layers as well.
Figure 4.9 Here, the source plate image (a) is shown along
with two alternates in which Camera Lens Blur has been
applied via an adjustment layer, held out by a mask. With the
adjustment layer blending mode set to Normal (b), there is a
subtle bloom of the background highlights, but changing it to
Add (c) causes the effect to be applied as in (b) and then added
over source image (a).

a

b

c
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Guide Layers
Like adjustment layers, guide layers are standard layers with
special status. A guide layer’s content appears in the current composition but not in any subsequent compositions
or the final render (unless it is specifically overridden in
Render Settings). You can use a guide layer for
.. foreground reference clips (picture-in-picture timing
reference, aspect ratio crop reference)
.. temporary backgrounds to check edges when creating
a matte
.. text notes to yourself
.. adjustment layers that are used only to check images
(described further in the next chapter); a layer can be
both an adjustment and a guide layer
.. View LUTs (Figure 4.10)
Any image layer can be converted to a guide layer either
by context-clicking it or by choosing Guide Layer from the
Layer menu.
Figure 4.10 There are many uses for
a guide layer; one simple one that is
common to most color and composit
ing applications is a View LUT in which
you apply an adjustment layer with a
LUT adjustment that is for previewing
only. When it comes time to render or
nest this clip, the guide layer provides
a guarantee that this layer and its ef
fect doesn’t show up.
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Image Pipeline, Global Performance Cache,
and Render Speed
The render pipeline is the order in which operations happen;
by controlling it, you can solve problems and overcome
bottlenecks. For the most part, render order is plainly
displayed in the timeline and follows consistent rules:

3D calculations are precise well
below the decimal level but do
round at some point. To avoid
render errors, precomp them in
a nested 2D layer.

.. 2D layers are calculated from the bottom to the top
of the layer stack—aka those numbered layers in
the timeline.
.. Layer properties (masks, effects, transforms, paint,
and type) are calculated in strict top-to-bottom order
within each layer (twirl down the layer to see it).
.. 3D layers are calculated based on distance from the
camera; coplanar 3D layers respect stacking order and
should behave like 2D layers relative to one another.

The Transform effect allows you
to position, scale, or rotate a layer
before other effects are applied,
solely to avoid precomping.

So to review: In a 2D composition, After Effects starts at
the bottom layer and calculates any adjustments to it in
the order that properties are shown, top to bottom. Then,
it calculates adjustments to the layer above it, composites
the two of them together, and moves up the stack in this
manner (Figure 4.11). Although effects within a given layer
are generally calculated prior to transforms, an adjustment
layer guarantees that its effects are rendered after the
transforms of all layers below it.
Track mattes and blending modes are applied last, after
all other layer properties (masks, effects, and transforms)
have been calculated, and after their own mask, effect, and
transform data are applied. Therefore, you don’t generally
need to pre-render a track matte simply because you’ve
added masks and effects to it.

Figure 4.11 2D layers render starting
with the bottom layer, rendering and
compositing each layer above in order.
Layer properties render in the order
shown when twirled down; there is
no direct way to change the order of
these categories.

Global Performance Cache: Way Faster!
The feature name Global Performance Cache is a generic
term for what is, in fact, a set of interrelated technologies:
.. a global RAM cache that is smarter about dividing your
work to save as many individual processes as possible
.. a persistent disk cache that saves those precalculated
processes for continual reuse
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.. a graphics pipeline that makes greater use of OpenGL
to present and stream images onscreen
Although After Effects doesn’t
prohibit you from doing so, don’t
apply a track matte to another
track matte and expect consistent
results. Sometimes it works, but it’s
not really supposed to work, and
most often it simply doesn’t.

Global Performance Cache is the result of looking at what
modern hardware can deliver that simply was not possible a few years ago, and figuring out how to make use of
that hardware:
.. cheap and plentiful RAM, and the ability of a 64-bit
operating system to access far more of it (up to 192 GB
on Windows 7, and well in excess of the 2 GB per
processor core recommended for After Effects)
.. fast attached storage, including SSD drives that routinely
double the access speed of even the fastest HDD drive
or array
.. high-end graphics cards with GPUs that accelerate
performance year after year at rates that way, way
outstrip Moore’s Law
Best of all, you don’t really have to do anything special,
beyond keeping your hardware up to date.
Memory Acceleration: Global RAM Cache
By slicing a clip with its many selections and effects into
discrete chunks and storing each of those render steps
individually, After Effects greatly reduces the need to
re-render cached footage. You can change a given
effect setting or range of keyframes without disrupting
other parts of the image and clip that are unrelated to
that change.
Reusable frames are recognized anywhere on the timeline:
when you use loop expressions (Chapters 8 and 10), remap
time, or copy and paste keyframes. Duplicated layers or
whole duplicated comps are also recognized.
The net result is that you can commit an edit, preview
the result without rendering from scratch, and undo the
change without penalty. Since this, in essence, is how you
spend your working day as an After Effects artist, the resulting 5–15x speed increase ripples throughout the process,
allowing you not only to get to a result more quickly but to
try more options without worrying about the time cost.

114

I: Working Foundations

This tends to work a lot better with 2D layers since in 3D,
light, reflection, shadows, refraction, and translucency are
all influenced by the adjustment of a single element, such
as a light or the position of a layer.
Continuous Access: Persistent Disk Cache
Data in the RAM cache is now much less fragile because it
is constantly backed up in a persistent disk cache. If you run
out of RAM, increment and save to a new version of the
project or even quit the application and reopen the project.
Its cache is available for instant playback and immediate
rendering (Figure 4.12b).

Want to see how caching behaves
on individual layers? Under the
Timeline panel menu, hold down
Ctrl/Cmd and click Show Cache
Indicators, even if it’s already
checked. Now each layer has its
own blue or green bar if it’s cached
(Figure 4.12a). Turn it off when
you have a good sense of how it
works, because it will slow down
your renders.

Figure 4.12 With Layer Cache Indica
tors on, you begin to see how After
Effects breaks down the RAM cache
into individual layers and even effects
(a). With fast attached storage, you will
see those green lines turn blue as they
move from RAM to the disk (b).

a

b

Persistent disk cache is also the most tweakable of the
Global Performance Cache options, and the one for which
your choice of hardware may make the greatest difference. Here’s a list of the most effective tweaks, followed by
a breakdown:
.. dedicate fast attached storage to the After Effects cache

After Effects Persistent Disk Cache
has been called “the closest thing
After Effects will ever get to a cure
for cancer.”

.. use the Cache Work Area in Background command as
you work
.. incorporate Dynamic Link with Adobe Premiere Pro
.. render locally
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Before drawing out the first three points in more detail,
note that the persistent disk cache is not at all sharable or
portable. Place the cache on a shared drive and point two
systems to it, and all you do is introduce instability: The two
systems don’t recognize those cached files in the same way,
thus introducing conflicts and instability, and will simply
continue to generate their own cache data. The data is
designed to be accessed instantly and is cleverly designed
to track a given comp and layers even as project versions
change on a given system (Figure 4.13).
Disk Cache Boost 1: Get Fast Attached Storage

Figure 4.13 If you were thinking the disk cache is
a bunch of easily recognized files you can share and
edit, think again!

How Do I Make More Frames Cache?
Not seeing as much of the blue line atop your
Timeline as you’d like? You basically have three
options: load more layers and effects, cheat, or get
faster storage.
Add enough render-heavy effects to a given 2D
layer, and at some point it will cache. Similarly, you
can hack the preferences file (using instructions
later in this chapter) and change the “proclivity”
preference, the basic metric for caching.
The real, practical solution is to get more and
faster attached storage. The faster the physical
disk you have available for the hard-disk cache, the
more likely that it will pass the speed threshold to
be used instead of simple re-rendering elements.
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The persistent disk cache can be a little like a gigantic
RAM extension, providing much longer memory and far
greater capacity. As such, it’s in your interest to maximize
its performance and, if possible, capacity. Why? Not only
because faster is better; After Effects actively evaluates
whether it’s in the application’s best interests to commit
a given process to disk. The greater the difference between
processor and cache speed, the more likely a frame gets
the blue cache indicator, ready to turn green at any time
(and the faster it turns green, the faster it is ready for
real time).
If you’re working in After Effects on a laptop, the ideal
setup is to install an SSD as your boot disk and main cache.
This has the added benefits of rebooting and launching all
applications more quickly, but means you probably want
two internal drives, so that a larger, cheaper one can be
used for longer-term storage.
In a desktop system, an SSD boot drive is equally valid,
but you also have higher-performing options, such as the
Fusion ioFX, which at this writing has just been raised to
1.6 TB of capacity via a PCI Express slot. It’s sort of like
having an SSD RAID, and if you have the cash, it may well
be a component in the highest-performing After Effects
computer you can build today (Figure 4.14).
Even that striped RAID array you have attached to your
system can help you a bunch. Any drive other than the
internal boot drive will work better, and if you edit footage
professionally, you almost certainly already have just such
a dedicated drive available.
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Disk Cache Boost 2: Commit a Comp
If you really hate waiting for a comp to preview and have
a half-decent system and something better to do with your
time, you can select a whole set of comps in the Project
panel and cache them. Yes, if you’re on a non-CUDAenabled MacBook Pro and those comps are all full of HD
ray-traced 3D animations, your system is going to sound
like a jet preparing for takeoff and your laptop will scorch
your lap. On the other hand, if you’re on one of those
systems that has more processor cores than you can count
when you open up their little capacity meters in the system,
well, you are finally going to get your money’s worth.
Caveats? Downsides? You gotta pay to play. This is where
gobs of low-latency storage is going to be your new best
friend, other than the actual best friend that you get
to spend time with when you are done for the day and
not already burning the midnight oil. But there’s always
that CBB.

Figure 4.14 Sure, this may be the
geekiest image in the book, but the
results of this system addition are
pretty sexy.

CBB stands either for Can’t Be
Bothered or Could Be Better. Both
apply in visual effects circles, but
unfortunately it’s the latter that
got the moniker.

Disk Cache Boost 3: Rethink Dynamic Link
Adobe Premiere Pro has a unique ability to link directly
to an After Effects comp. Dynamic Link is a feature that
allows Adobe Premiere Pro to actually look inside an After
Effects project for an existing comp that it can import
(Figure 4.15), or designate a clip in a sequence as the basis
for a new After Effects comp.
Figure 4.15 If you’ve never witnessed the power of
Dynamic Link to peer inside an After Effects project
from Adobe Premiere Pro or Adobe Media Encoder,
it may seem like magic.
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Preferences > General > Dynamic
Link with After Effects Uses Project
File Name with Highest Number
is unchecked by default, but it
could instead simply be called
Make Dynamic Link Usable in the
Real World.

Preferences > Display > Show
Rendering Progress in Info
Panel and Flowchart shows what
is happening on your system. It
is disabled by default because
it requires some extra processing power, but you may find
you get that time back from the
ability to spot and solve an obvious bottleneck.

With either approach, there is an actual, live After Effects
comp sitting in an Adobe Premiere Pro sequence. After
Effects invisibly provides the ability to render it in the
background. As any change is made to the comp on the
After Effects side, it remains up to date in the Adobe
Premiere Pro edit.
One drawback to embedding an After Effects composition
into the Adobe Premiere Pro timeline in this manner is
that the latter application lacks all of the means immediately at your disposal in After Effects to speed up a preview
by lowering settings. It’s all or nothing to cache a clip in
the Adobe Premiere Pro timeline, without much certainty
how long such a preview will even take.
If you’re thinking that Global Performance Cache helps
in such a case, you are correct. Suppose you have a heavy
comp that requires 10 seconds to render each frame at full
resolution. If you cache the comp at full, Adobe Premiere
Pro has access to those cached frames even if After Effects
isn’t open. Render the sequence and that clip is ready for
real-time playback in seconds, not minutes or hours.
Note that you do, however, still have to render to get rid of
the red line above that clip, even if it’s completely cached
at full resolution. And, when you do so, it doesn’t add to
the After Effects cache. The way to make this work is to
generate a preview in After Effects. This still requires you to
perform an edit, but once you do so, it helps speed up the
Adobe Premiere Pro timeline just as it does in After Effects.
Proxies, Previews, and Network Renders
Previous editions of this book advocated the use of proxies
and previews as ways to accelerate the previewing and rendering process. This is exactly where Global Performance
Cache changes the game, but only as long as you work on
the “one artist, one project, one system” model, given that
the cache is neither portable nor sharable.
For this reason, the old ways are still valid in any case where a
project needs to be moved or shared, even if only for rendering purposes. The good news is that the cached data helps
even this process to happen much more efficiently, because
it is also used to render on the system that generated it.
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Post-Render Options
Tucked away in the Render Queue panel, but easily visible
if you twirl down the arrow next to Output Module, is a
menu of three post-render actions to incorporate a render
into a project. After the render is complete, you can use
.. Import simply to bring the result back into the project
.. Import & Replace Usage to replace the usage of the
source comp in the project without blowing it away
.. Set Proxy to add a proxy to the source (the most
elegant solution, but the most high maintenance)
The latter two options even let you use the pick whip icon
adjacent to the menu to connect whatever item in the
Project panel needs replacement. If you’ve already created
a pre-render or proxy, you can target that (Figure 4.16).

File Name Templates
Want to get super-swanky and elegant with
your Render Queue output? Right next to each
specified filename is a little pull-down menu that
lets you choose from a set of name templates. A
few different properties such as project or output
module name can be automatically added to the
name string, and if you click Custom, that’s where
the real magic begins. Here you can customize
your own from a couple of dozen different criteria
under the Add Property menu, and check the
Default box for the one you want to use instead of
using a simple comp name for all future renders.

Figure 4.16 Virtually any project item can be the target for replacement or a proxy. Click and drag the pick whip icon to
choose the item to be replaced by the render.

Proxies and Pre-Renders
Let’s face it, dutifully rendering proxies is boring and will
seem completely unnecessary with all of the new cache
features—right up until the moment when you’re in a
rush and no longer have access to that cache, either when
rendering remotely or handing off the project. Are you
willing to buy some insurance on that cache? If so, this
section is for you.
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To remove a proxy from a project,
select the item or items with
proxies, context-click (or go to
the File menu), and choose Set
Proxy > None.

Any image or clip in your Project panel can be set with a
proxy, which is an imported image or sequence that stands
in for that item. Its pixel dimensions, color space, compression, even its length and frame rate, can differ from the
item it replaces. You can have a quick-and-dirty still or
low-res, compressed, low-frame-rate clip stand in for a
render-heavy comp.
To create a proxy, context-click an item in the Project panel
and choose Create Proxy > Movie (or Still). A Render Queue
item is created and, by default, renders at Draft quality and
half-resolution; the Output Module settings create a video
file with alpha, so that transparency is preserved and
Post-Render Action uses the Set Proxy setting.

Figure 4.17 The black square icon to
the left of an item in the Project panel
indicates that a proxy is enabled; a
hollow square indicates that a proxy is
assigned but not currently active. Both
items are listed atop the Project panel,
the active one in bold.

Figure 4.17 shows how a proxy appears in the Project panel.
Although the scale of the proxy differs from that of the
source item, it is scaled automatically so that transform
settings remain consistent. This is what proxies seem to
have been designed to do: allow a low-resolution file to
stand in, temporarily and nondestructively, for the highresolution final.
There’s another use for proxies. Instead of creating
low-res temp versions, you can instead generate final quality
pre-rendered elements. With a composition selected,
choose Composition > Pre-render and change the settings
to Best for Quality and Full for Resolution, making certain
that Import and Replace Usage is set for Output Module.
Here’s the key: By default, the source file or composition is
used to render unless specifically set otherwise in Render
Settings > Proxy Use. Choose Use Comp Proxies Only, Use
All Proxies, or Current Settings (Figure 4.18) and proxies
can be used in the final render. Thus the speed and quality

Figure 4.18 I typically set Proxy Use
to Current Settings, but Use Comp
Proxies Only lets you set low-res
stand-ins for footage and full-reso
lution pre-renders for comps, saving
gobs of time.
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boost that the proxy provided as you worked can now also
contribute to your render, even if the project (with its
source) travels to another system.
Background Renders
Rendering from the Render Queue ties up the application
and much of the machine’s processing power, which used
to mean that renders were left until lunchtime or off-hours.
On a modern system with multiple processors, you can
do much better than that (but take breaks anyway, they’re
good for you).
Adobe Media Encoder
It is too often overlooked that Adobe provides a background rendering application. Adobe Media Encoder
(AME) is in many ways a superior alternative to the Render
Queue. It can write formats such as DNxHD that After
Effects can’t, and it can optimize other formats that benefit
from multi-pass rendering, in particular H.264. H.264 is a
“long GOP” format, which means that it relies on keyframes
with lots of image data surrounded by in-between frames
that rely on them, and all of the frames must be rendered
before it can work its magic. Only Adobe Media Encoder
collects frames to compress them instead of writing each
frame as it is rendered, and only it includes presets for
many common web video services and mobile devices.
Choose Composition > Add To Adobe Media Encoder Queue
to send a comp directly, or you can drag and drop an After
Effects project into Adobe Media Encoder and look inside
the project for renderable comps (Figure 4.19). You then
choose render settings either by selecting them from the
Preset Browser or customizing the settings (by clicking on
the Preset for the render item and specifying your own,
which you can then save as a custom preset of your own).
If you can get used to an unfamiliar user interface that
doesn’t match the Render Queue, you begin to reap the
greatest reward of AME: background rendering. And once
you have created the presets you use most often, you may
even find that the UI mismatch isn’t such a big deal.

Render, Email, Save, and Shutdown
by Lloyd Alvarez (http://aescripts.
com/render-email-incrementalsave-and-shutdown/) does just
what it says; just queue up your
render and when it’s completed,
your system can notify you, save
the project and shut down.
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Figure 4.19 Dynamic Link allows
other Adobe applications to see your
Project panel; Adobe Media Encoder
uses this to let you render comps for
heavily compressed video formats
directly from the project.

BG Renderer by Lloyd Alvarez
(http://aescripts.com/
bg-renderer/) may be the most
universally used After Effects script.
Not only does it automatically
set up a background render by
creating the command line for you,
but it offers you a user interface for
extra variables you might miss that
determine the priority and number
of processors used to render
(Figure 4.20).

Figure 4.20 BG Renderer uses
ScriptUI, which means that it looks
like it’s part of the interface and can
remain in an open panel as you work.
When you’re ready to render, you can
specify priority and number of proces
sors. Click the button and a terminal
window opens that shows the render
progress, line by line. You may miss the
progress bar of the Render Queue, but
if you can live without that, the benefit
is that you can keep working while
your machine renders.
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aerender
Background rendering allows a render to occur without the
user interface, allowing you to continue working with it.
The aerender application is found alongside the After
Effects application on your system but runs via a command
line (in Terminal Unix shell on Mac OS or the command
shell in Windows). You can drag it into the shell window to
run it, or press Enter (Return) to reveal its Unix manual
pages. This lists the arguments that can be added in quotes
to the command aerender and the location string of the
project file.
But that’s all such geeky gobbledygook when you have the
BG Renderer script, which gives you access to all of these
options via a panel in the After Effects UIs, with no need
to type any code.
Network Rendering
The aerender command is also used by third-party rendering
solutions that work a lot like BG Renderer but are distributed
across multiple machines on a network. These programs
can manage renders on multiple machines and perform
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tricky operations like pause a render until an updated
element from 3D is done or automatically re-queue failed
renders. Because these third-party rendering options—
Rush Render Queue, Pipeline’s Qube!, Überware’s Smedge,
or Muster by Virtual Vertex, to name a few—also support
other terminal-friendly applications, such as Maya and
Nuke, it’s an investment facilities that are large enough to
have a render farm don’t have to think twice about making.
These are not one-click installs, and they’re generally justified only by dedicated machines and a dedicated nerd to
manage it all. If that’s beyond your facility at this point,
you can still take advantage of all of this technology via the
Cloud or via a service such as Render Rocket. You upload
your source files and get back rendered output. The
downside for compositors is that we generally require a lot
of source data to produce final shots, compared with 3D
artists who can sometimes create a final cinematic image
with virtually no source.
Watch Folder
The slightly dotty granddaddy of network rendering on
After Effects is Watch Folder (File > Watch Folder). Watch
Folder looks in a given folder for projects ready to be rendered; these are set up using the Collect Files option. The
Adobe Help topic “Network rendering with watch folders
and render engines” includes everything you need to know.
Watch Folder is kind of okay on small, intimate networks,
but it requires much more hands-on effort than dedicated
render management software, and it breaks easily, at which
point it requires human intervention. Since individual
systems have become so powerful, it’s easy to become lazy
about taking the trouble required to set up a Watch Folder
render, but if you’re up against a deadline, don’t have
the dedicated software, and want to maximize multiple
machines, it will do the trick.

Multiple After Effects Versions
When you’re desperate, you can open more than
one After Effects on Mac OS or Windows. This is
memory intensive and not ideal for rendering (for
which BG Renderer is much preferred), but it lets
you work with two projects at once.
On Mac OS, locate the Adobe After Effects application and duplicate it (Cmd+D); both will run
after you clear the warning that the application
has moved. On Windows, go to the Start menu,
choose Run, type cmd, and click OK. In the DOS
shell that opens, drag in AfterFX.exe from your
Programs folder and then add –m (that’s a space,
a dash, and m as in “multiple”). Voilà, a second
version initializes.
If you’re merely trying to speed up rendering, it’s
recommended that you instead enable the Render
Multiple Frames Simultaneously option under
Preferences > Memory and Multiprocessing, leaving “Only for Render Queue, not for RAM Preview”
checked—or go with BG Renderer.

Use Dropbox to Remotely Monitor Renders
Add an output module that writes low-resolution
JPEG stills to a Dropbox folder, and you can check
that folder for render progress and review the
actual frames anywhere if you have a device such
as an iPhone that can include a Dropbox app.
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Optimize a Project
Setting Preferences and Project Settings
Here are a few default preferences I always change:
.. Preferences > General > Levels of

Undo: Got RAM? Set this to 99.
.. Preferences > General: Check the options

Allow Scripts to Write Files and Access Network.
.. Preferences > General: Toggle Default

Spatial Interpolation to Linear.
.. Preferences > General: Dynamic Link with

After Effects Uses Project File Name with
Highest Number.
.. Preferences > Display: Check all four boxes

(unless you love those little thumbnails; they
can slow you down on a network).
.. Preferences > Import: 29.97 for broadcast,

24 fps for film, 23.976 for both (film for broadcast), and 25 fps for PAL-derived systems.
.. Preferences > Media & Disk Cache: Choose

a folder on a fast, attached disk.
.. Preferences > Appearance: Turn Cycle

Mask Colors on.
.. Preferences > Auto-Save: On.

Here are a few more workflow tweaks to get the best performance out of After Effects.
Hack Shortcuts, Text Preferences, or Projects
Some people are comfortable sorting through lines of
code gibberish to find editable tidbits. If you’re one of
those people, After Effects Shortcuts and Preferences
are saved as text files that are fully editable and relatively
easy to understand. Unless you’re comfortable with basic
hacking (learning how code works by looking at other bits
of code), however, I don’t recommend it. The files are
located as follows:
.. Windows: [drive]:\Users\[user name]\AppData\
Roaming\Adobe\After Effects\12.0
.. Mac: [drive]:/Users/[user profile]/Library/
Preferences/Adobe/After Effects/12.0/
Mac OS X started hiding the User/Library folder with the
release of 10.7 (Lion). The easiest way to reveal it from the
Finder is to select Go > Go to Folder and then type Library.
The names of the files are
.. Adobe After Effects 12.0-x64 Prefs.txt
.. Adobe After Effects 12.0 Shortcuts

Press Alt+Ctrl+Shift
(Opt+Cmd+Shift) immediately
after launching After Effects to
reset Preferences. Hold Alt (Opt)
while clicking OK to delete the
shortcuts file as well.
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These can be opened with any text editor that doesn’t add
its own formatting and works with Unicode. Make a backup
copy before editing by simply duplicating the file (any
variation in the filename causes it not to be recognized by
After Effects). Revert to the backup by giving it the original
filename should anything start to go haywire after the edit.
The Shortcuts file includes a bunch of comments at the top
(each line begins with a # sign). The shortcuts are arranged
in a specific order that must be preserved, and if you add
anything, it must be substituted in the exact right place.

I: Working Foundations

Be extra careful when editing Preferences; a stray character in this file can make After Effects unstable. Most of the
contents should not be touched, but here’s one example
of a simple and useful edit (for studios where a dot is
preferred before the number prefix instead of the underscore): Change
“Sequence number prefix” = “_”

to

A fantastic script for specifying your own modifier keys
called KeyEd Up was developed
specifically for After Effects by Jeff
Almasol, author of other scripts
included with this book. Find it on
Adobe After Effects Exchange at
http://tinyurl.com/6cu6nq.

“Sequence number prefix” = “.”

This is the format often preferred by Maya, for example.
In other cases, a simple and easily comprehensible numerical value can be changed:
“Eye Dropper Sample Size No Modifier” = “1”
“Eye Dropper Sample Size With Modifier” = “5”

In many cases, the value after the = is a binary yes/no
value, expressed as 0 for no and 1 for yes, so if you’re
nostalgic for how the After Effects render chime sounded
in its first several versions, find

pt_OpenSesame by Paul Tuersley
saves and reads projects in a
human-readable, plain-text format
in which its relatively straightforward to make all sorts of changes.

“Play classic render chime” = “0”

and change the 0 to a 1. Save the file, restart After Effects,
and invoke those 20th-century glory days of the beige Mac.
XML and Open Sesame
After Effects projects can be saved as .aepx files. These
work the same way but are written in plain Unicode text;
you can edit them with an ordinary text editor. Most of
what is in these files is untouchable; the main use is to
locate and change file paths to swap footage sources without having to do so manually in the UI. If that means nothing to you, you’re probably not the shell scripting nerd
for whom a feature like that was created, but you might
instead want to take a look at Open Sesame.

On the Mac: Force a Crash
When After Effects does crash, it attempts to do
so gracefully, offering the option to save before
it exits. The auto-save options, if used properly,
further diminish the likelihood of losing project
data. On Mac OS X, an extra feature may come in
handy when the application becomes unresponsive without crashing.
Open Activity Monitor and look for After Effects
to get its PID number. Now open Terminal, and
enter kill –SEGV ### where “###” is replaced by the After Effects PID value. This should
cause the application to crash and auto-save.
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Chapter 4 Optimize Projects

Sync Settings
Although the RAM cache is less
likely to become full or fragmented with 64-bit processing,
Throttle-n-Purge by Lloyd Alvarez
(http://aescripts.com/throttlen-purge/) provides a UI panel
with a one-button solution to
clear all caches and get maximum
efficiency out of a preview render
(Figure 4.21). It also lets you
switch bit depths more easily than
the Project panel, and it lets you
turn multiprocessing on and off
without opening Preferences.

Throughout Section I of this book we’ve looked at options
that influence how you set your Preferences. Once you
have them the way you like them, After Effects now allows
you to sync them to your Creative Cloud account so that
you can simply load them wherever you go. Just below the
Preferences menu item, if you are logged in you will see
your login address as a menu item with the option to Sync
Settings Now.
It’s not just preferences that are uploaded to be reused
later. Keyboard shortcuts, render settings and even composition settings presets are transferred. To recover these
or transfer them to another system, log in and choose Use
Settings From A Different Account from the Edit menu
(Windows) or After Effects menu (Mac).
Make sure to go to Preferences > Sync Settings and check
Output Modules Settings Templates to sync your custom
Output Modules as well. This isn’t enabled by default
simply to avoid the conflicts between settings with the same
name on Mac and Windows, such as Lossless. If it’s a concern not to mess up these settings, make sure to rename
the redundant ones.

Figure 4.21 Throttle-n-Purge exposes
controls to help you manage memory
usage as well as offering a one-button
option to purge all caches (undos and
image buffers) and start over.

These Are the Fundamentals
You’ve reached the end of Section I (if you’re reading
this book linearly, that is), and we’ve done everything we
could think of to raise your game with the After Effects
workflow. Now it’s time to focus more specifically on
the art of visual effects. Section II, “Effects Compositing
Essentials,” will teach you the techniques, and Section III,
“Creative Explorations,” will show you how they work in
specific effects situations.
So here comes the fun part.
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Symbols
(*) asterisk key, in Timeline, 38
& (luminance), 182
(--) decrement operator, in JavaScript,
332
~ (tilde) keyboard shortcut, 7, 9

Numbers
1.0 gamma. See linear blending
1.85 Academy aperture, 316
2D
adjustment layers in, 111, 113
color correction in, 159–160
decoding motion blur in, 59
heat distortion in, 444
for illusion of depth in 3D space,
263
liquid layers in, 421
matting 3D layer with, 99
render pipeline rules for, 113
scaling in, 292–293
shapes in, 87
tracking in mocha AE, 256–257
tracking motion between 2D and,
339–346
Transform controls in, 42
2k displays
crop effect for, 241
lighting for, 192–193
monitor setup for, 9
2.2 gamma value, in Windows, 360
2.35:1 Cinemascope format, 316–317
2.39:1 widescreen format, 317–318,
398
2.4:1 widescreen format, 317
3D
2D as track matte for, 99
Advanced tab of, 50
anchor point in, 56–57
camera animation in, 291–293
camera projection into, 295–298
camera settings in, 269–278
Cinema 4D and. See Cinema 4D
Collapse Transformations in,
108–109
compositing in, 159–160, 299–301
depth maps in, 414–416
emulating 2D data as, 256
explosions in, 451–452
illusion of fire in, 449–450
light falloff in, 384–386
lights in linearized working
space, 371
motion blur in, 59, 61–62
multipass compositing in,
404–409
nesting layers in, 107

render frames with
placeholder, 10
render pipeline for, 113
render with Fast Draft, 25
replacement sky in, 418
Rotation property in, 42
shadows in, 401–403
smoke trails in, 426–427
tracking data in, 263–265
tracking motion between 2D and,
339–345
3D Camera Tracker
limitations of, 236
mocha AE vs., 261
refining Camera Track in, 233–235
for replacement sky, 418
tracking scene, 231–233
understanding, 231
unsolvable shots in, 235–236
3D LUTs (look-up tables), 377–378,
391
3D Point Control, 343
3D tracking
in 3D Camera Tracker, 232
data, 263–264
for fire, 449
workflow, 263
.3DL file, 378
4:1:1 compression, 182
4:2:0 compression, 182
4:3 aspect ratio, 317–318
8-bpc (bits per channel)
16-bpc color vs., 139, 351–352
standard dynamic range of, 354
video gamma space and,
360–361
10-bit Cineon, 358
16-bpc (bits per channel)
color matching in ordinary
lighting, 150
composites, 351–352
shortcut for switching to, 139
16:9 widescreen format (HDTV
standard), 317–318
23.976 fps (frames per second)
applying wiggle time, 337
frame rate and, 18
using Roto Brush, 206
24 fps (frames per second)
avoiding unwanted motion blur,
244
for Cinema 4D, 280
for composition setup, 6
pulldown allowing for, 19
realism and, 316–317
rendering for 29.97 video, 30
shutter speed for, 59–60, 244

29.97 fps (frames per second),
316–317
30 fps (frames per second), 6, 19
32-bpc (bits per channel)
blending colors using 1.0
Gamma, 370–371
color management in, 374
Compander for, 369–370
dynamic range of, 355
in linear HDR compositing,
366–367
output, 372–373
overview of, 367–369
35 mm film, 318
35 mm lens, 271
48 fps (frames per second) HFR, 316
50 mm lens, 270–271
80/20 rule, for blending modes, 92

A
A over B composites, 3, 72
Adapt Feature on Every Frame,
253–254
Adaptive Sample Limit, Motion
Blur, 59
Add Bezier spline, mocha AE, 262
Add blending mode
for bullet-hit explosions, 437–438
for fire, 447
for masks, 88–89
for multipass renders, 407
Multiply mode vs., 419
for wispy smoke, mist, or fog, 419
working with, 92–94
Add transfer mode, 365–366
Add with Invert mode, 88–89
Add X-spline, in mocha AE, 262
Additional Edge Radius, Refine Soft
Matte, 188
Adjust Tension pointer, 218
adjustment layers
applying grayscale maps as luma
mattes for, 407–408
blending modes and, 96
color assignment to, 38
depth maps for, 415
for fire, 447
guide layers used as, 112
for heat distortion, 445
layer locks for, 38
in project optimization, 110–111
for storms, 428–429
Adobe Media Encoder (AME), 26, 121
advanced color options. See color,
advanced options
advanced composition settings,
109–110
Advanced Lightning, 443
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advanced options, Warp Stabilizer
VFX, 243
.aepx files, 125
aerender, 122
Aligned toggle, Paint panel, 224
All Panels workspace, 4
Allow Keyframes Between Frames, 52
Almosol, Jeff
automatic camera projection
setup script, 296
KeyedUp by, 125
light wrap formula by, 395
Pre-compose by, 103
Alpha Add blending mode, 90
Alpha Bias, 181
Alpha Boundary, Roto Brush, 209
alpha channels
blending modes, 95
interpretation, 17, 82–84
paint for, 221, 222
in selections, 74
track mattes vs., 97
Alpha Inverted Matte, 97
Alpha Matte, 97
Alpha Overlay, Roto Brush, 209–210
alpha track mattes
for animated masks, 90
removing grain in blue/
greenscreens using, 311
for shadows, 403
Alpha view, Roto Brush, 209
Alvarez, Lloyd
Arrange Project Items into
Folders by, 105
BG Renderer by, 122
Immigration by, 10
Layer Tagger by, 38
Load Project or Template at
Startup by, 105
Render, Email, Save, and
Shutdown by, 121
Throttle-n-Purge by, 126
ambient motion, 425–427
AME (Adobe Media Encoder), 26, 121
amplitude, 326–328
Analysis Tools panel, SpeedGrade,
390
anamorphic lens flare, 398
anchor points
keyboard shortcut, 42
repositioning with Pan Behind, 56
Stabilize tracks applied to, 251
Angle Control, 343
angle of view
in 3D Camera Tracker, 234
for camera, 271–273
animated masks, 90–91
animation
in-between, 214
of ambient motion, 425–426
anchor point in, 56
in camera, 291–293
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copy and paste, 50–51
in Graph Editor, 44–50
keyframe, 214
of masks, 90–91
parent hierarchy in, 57–58
presets for composites, 29–30
relationships in, 55–58
strobe, 334
Timeline for. See Timeline panel
triggering at markers, 334–335
of wind, 425–427
Annable, Graham, 69
Aperture, 299–301
aperture blades, lens flare, 314, 398
arithmetic operators, 328
Arrange Project Items into
Folders, 105
Arri Alexa cameras, 197
ARRI LogC, 379
articulated mattes, 214–217
ASA settings
in camera reports for shoot, 273
excessive grain triggers, 307
grain removal and, 310
aspect ratios, in distortion, 313
assembling shots logically, 33–34
asterisk key (*), in Timeline, 38
atmospheric haze. See particulate
matter
attached storage, 114–116
Audio Settings, 15
Auto Bezier, 50
Auto Detect, 3D Camera Tracker, 234
Auto Levels, 137
Auto-Save, 14, 125
Auto-Scale, Warp Stabilizer VFX
cropping in, 241
improving, 240
Smoothness settings in, 240–241
for stabilization of shot, 238
Synthesize Edges in, 241
Auto Select Graph Type, 45
Auto-trace, 76
Avatar, 404
Average Error
in 3D Camera Tracker, 233–235
in Cinema 4D Lite, 287

B
background rendering, 121–123
backgrounds
in 3D Camera Tracker, 231–233,
234
camera zoom in, 292
in Cinema 4D Lite, 289–290
customizing in composites, 27–29
defocusing with bokeh, 306
depth cues for particulate matter
and, 414
for depth maps, 414–416
for fabricated smoke, 420
for fire, 447–448

isolating object/plane in,
244–245
keying out for mattes, 73
for light wraps, 396
lighting on sets for, 198–200
matching foreground colors to.
See matching colors
in point stabilization, 247–248
in sky replacement, 416–418
stabilization of shot as process
in, 238
backlighting, 396–397
backplate, 271
backwards compatibility, 16
banding, 139, 352
barrel distortion, 276–278
base frame, 208
Beam (light saber) effect, 440–443
bell-curve distribution, 336, 339
Bezier
handles, 423
masks, 86
motion paths, 50
rotobezier shapes vs., 217–218
splines, 258
BG Renderer, 122
Bias settings, in Keylight, 181
billowing smoke, 422–424
Birn, Jeremy, 405
bit-depth identifier, 139
bitmap alpha edges, 78–79
bits per channel (bpc). See specific
numbers of bpc
black
in bitmaps, 78
in Cineon log files, 354–355,
358–359
in color keying. See color keying
contrast adjustments, 130–133
in depth maps, 303
in Difference mode, 95
in edge premultiplication, 81
in Extract, 167, 447
hex color values for, 373
input. See Input Black/Input
White
in Luminescent Premultiply,
96–97
on monitors, 91, 355
with no clear reference, 157–158
in ordinary lighting, 150–152
pixel values in, 33, 73, 91–92
in Screen mode, 92
shooting fires against, 446–447
as transparency in mattes, 73
Black & White effect, 392–395
black box technology, 186
Blade Runner, 423
Blend Colors Using 1.0 Gamma
enabling in all color modes, 366
in fire composites, 447
for linear blending, 92

Index
linear blending without 32-bpc
HDR, 366
in multipass renders, 407
working with, 370–371
blending modes
Add, 92–94
for adjustment layers, 111
for bullet-hit explosions, 437–438
Color, 95
Difference, 95
for fire, 447
HSB, 95
introduction to, 76
in layers with Collapsed
Transformations, 108
Light, 94
for light wrap, 396–397
Luminescent Premultiply, 96–97
in multipass renders, 407
Multiply, 94
Overlay, 94
Preserve Underlying
Transparency, 95–96
render pipeline rules, 113
Screen, 94
Silhouette, 95
Stencil, 95
for wispy smoke, mist, or fog, 419
Block Size, 67
blue channel. See also RGB
(red, green, blue)
for chromatic aberration, 316
in color keying, 168
in Extract, 167
in noise suppression, 183
refining grain settings, 308
bluescreens
applying instance of Keylight
to, 173
cameras for shooting, 196–197
in color keying, 171–179, 201
in cyclorama, 198
fine-tuning image quality, 185
garbage matte mask added to, 75
improving with Remove
Grain, 311
mattes resulting from, 73
overview of, 171
Screen Balance for, 181
sky as, 417, 419, 426
suppressing color spill, 195
blur
adding grain with, 311
bokeh. See bokeh blur
Box Blur, 402
Camera Lens. See Camera Lens
Blur
Compound Blur, 447
Fast Blur. See Fast Blur
Gaussian Blur, 402
in light saber methodology,

440–443
motion. See motion blur
in native video space vs. linear
space, 363–365
blur maps, 303–306
Blur Radius
Beam effect, 440
Camera Lens Blur, 302
bokeh blur
adding with Diffraction Fringe,
303
chromatic aberration with, 316
defined, 297
as lens artifact, 273, 312–313
understanding, 297–298
Box Blur, 402
Brightness & Contrast, 130–133
brightness adjustments
in Add and Screen modes, 92–93
in Cineon log space, 356–357
Curves control for, 139–145
digital film and, 357–359
dynamic range and, 354–356
Gamma control for, 133–134
HSB blending modes for, 95
input values for. See Input
Black/Input White
in linearized workspace, 361–363
in native video space vs. linear
space, 363–365
output values for. See Output
Black/Output White
in video gamma space, 360–361
for wispy smoke, mist, or fog, 419
Brush Dynamics setting, 222
Brush Tips panel, 221–223
Brush tool, 221–223
brushes, Liquify, 424
bullets
hits and squibs, 438
shells and interactive light
from, 437
the shoot for, 435–436

C
cache. See also disk caching
for composites, 27–29
persistent disk cache, 115
purging RAM, 126
Cache Work Area in Background, in
Global Performance Cache, 103, 115
Calibration LUTs, 378
camera
3D and Cinema 4D. See Cinema
4D
animation, 291–293
Camera Lens Blur, 301–307
Camera Settings, 269–272
chromatic aberration by, 315–316
for color keying, 196–197
commands, 279

focal depth and 3D compositing,
299–301
focal depth and bokeh blur,
296–298
formats and, 317–318
frame rates and, 316–317
grain, 307–312
lens artifacts by, 312
lens data, 273–275
lens distortion, 275–278
lens flare, 313–314
lens settings, 270–271
less color is more, 318–320
panoramas in, 317–318
projection, 294–298
push and zoom, 292–293
real camera emulation of,
272–273
real camera settings of, 271–272
seeing with, 269
telling story with, 290–291
tracking motion of. See motion
tracking
understanding, 268
unreality of, 269
vignettes and, 312, 315
Camera Lens Blur
adding blur map, 303–305
bokeh and, 306–307
fixing blur map edges, 305–306
understanding, 301–303
camera projection (mapping),
294–296
camera, real-world
After Effects camera vs., 271–273
chromatic aberration by, 315–316
color choices of, 318–319
formats in, 317–318
frame rates in, 316–317
lens artifacts by, 313
lens flare by, 313–314
lens length numbers on motion
picture, 271
panoramas in, 317–318
recording lens data, 273–275
shooting for stabilization,
237–239, 244
training your eye with, 320
vignettes in, 173, 312, 315
Camera Tracker. See 3D Camera
Tracker
Caps Lock, 24–25
caret sliders, Levels, 129
CC
Lens effect, 326, 431
Light Burst 2.5, 342
Light Rays effect, 401
Simple Wire Removal tool, 226
CG 101: A Computer Graphics Industry
Reference, 73
Channel Blur, 183

455

Index
Channel Combiner effect
in chroma subsampling, 182
in edge fringing, 84
in noise suppression, 183
Channel Control menu,
Hue/Saturation, 146
Channel menus, 135–136
Channel selector, Curves, 140
channels. See color channels
Chapman, Brennan, 107
Chatter Reduction
in Refine Edge brush, 213
in Refine Soft Matte, 188
in Roto Brush, 210
Checkbox Control, 343
chewy mattes, 166, 185–190
Choke Matte value, 168, 178
choking mattes, 184, 193
chroma subsampling, 182
chromatic aberration, 313, 315–316
CIN file format, Cineon, 21, 353–354
Cinema 4D
Cineware in, 279–280
Lite, 285–290
preparing comps for, 280
render and layer settings in,
283–285
sharing in, 281–283
understanding, 279
working with any current version
of, 280–281
Cineon
color space, 361
digital film in, 357–359
dynamic range in, 353
Log space in, 356–359
output, 372
overview of, 353–354
Cineware
individual render passes in, 405
overview of, 279–280
sharing camera data with,
281–284
versions of Cinema 4D for,
280–281
circles of confusion, 302
Citizen Kane, 297
clean plates, defined, 129
climate. See environment
Clip Black control
in Keylight, 175, 177, 179, 182
in Refine Soft Matte, 188
Clip Rollback control, 183
Clip White control
in Keylight, 175, 177, 182
in Refine Soft Matte, 188
Clone Stamp, 221, 422
cloning, 223–226
clouds
for billowing smoke, 422–424
contrails for, 426–427
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moving through wispy, 421–422
wispy, 419–421
CMOS sensor cameras, 244
Collapse Transformations, 107–109
Collect Source Files, 13–14
color
adjusting in Levels, 129
advanced options for. See color,
advanced options
backgrounds in composites,
27–29
blending modes for, 95
in Camera Lens Blur, 304–305
in chromatic aberration effect,
313, 315–316
commentary, in Timeline, 37–38
Compander and, 369
correcting. See color correction
default expressions changing
property, 324
depths. See color depths
distortion in cameras, 312–316
layer management with, 38
and light. See light
in linear interpolation, 343–345
in linearized working space, 363,
366–367
look of. See color looks
management, 373–379
matching. See color matching
in multipass rendering, 405–409
nonlinear response to, 360–361
Project Settings for, 15
sampling and conversion of,
346–347
spaces, encoding, 358–359
spill, 184–185, 196
timing, 148
color, advanced options
16-bpc composites and, 351–352
Cineon Log space and, 356–359
digital film and, 357–359
dynamic range and, 354–356
film and Cineon files in, 353–354
linear compositing and. See linear
HDR compositing
linear LDR compositing in,
373–379
linearized working space in,
361–363
understanding, 350–351
video gamma space in, 360–361
Color Balance, 443
color blending
with 1.0 gamma. See linear
blending
modes for, 95
for tint effect, 135, 393
color channels
3D LUTs and, 377–379
adjusting in Levels, 129

color matching in dramatic
lighting, 153–157
color matching in ordinary
lighting, 151–153
color matching with individual,
135–136
for composites, 29
Extract effect for, 166–168
foreground/background
integration with, 148
Hue/Saturation and, 145–146
Color Control, 343
color correction. See also color looks
Auto Levels for, 137
brightness adjustments, 133–134
channels for, 136–138
contrast adjustments, 130–133
gamma exposure slamming,
160–161
histograms for, 136–139
Hue/Saturation for. See
Hue/Saturation
image optimization and, 129–136
importance of, 128–129
individual channels for, 135–136
Levels for. See Levels
matching foreground/
background. See matching
colors
Photoshop’s Curves control for,
138–145
summary of, 161
color depths
in color management, 374
Color Settings for, 15
composition setup and, 6
raising for project, 352
toggling between, 139, 368
color keying
adding grain when, 311
bluescreen for, 171–179
cameras for, 196–197
closing holes in, 193
color spill in, 195–196
core mattes in, 168, 177–178
costume contamination and, 196
edge mattes in, 177–179, 188, 192
edge selection in, 193–194
evaluating shot in full motion,
179
Extract effect for, 167–168
greenscreen for, 171–179
hi-con mattes for, 166–170
holdout mattes in, 190
Keylight for. See Keylight
lighting and, 198–200
Linear Color key for, 169–170
linear keyers for, 166–170
problem solving, 184–196
procedural mattes for, 164–166,
190–192
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refining mattes in, 174, 186–190
separating plates for multiple
passes in, 177–178
set contact and, 196–200
side-by-side layout in, 173–174
spill suppression in, 184–185
understanding, 164
color looks
backlighting for, 396–397
flares for, 397–398
light scattering for, 399–401
light volume for, 399–401
light wrap for, 396–397
reflected light for, 399
shadows for, 401–403
with SpeedGrade. See
SpeedGrade
understanding, 386
color matching. See also color
correction
basic technique, 148–149
direction and position for, 159
in dramatic lighting, 153–155
for fire, 447
importance of, 128–129
individual channels for, 135–136
with no clear reference, 155–158
in ordinary lighting, 149–153
overview of, 146–148
Color Picker, 362–363
color pots, SpeedGrade, 389
Color tab, SpeedGrade, 387–388
Colorista plug-in, 162, 386
column views, in Timeline, 36–37
combining projects, 13–14
comments, in comp template, 104
comp space
coordinate system for, 340
to layer surface, 345–346
Compander effect, 369–370
composites. See also linear HDR
compositing
alpha channel interpretation
in, 17
animation presets for, 29–30
assembling shots logically, 33–34
basic, 2–5
caching, 27–29
for Cinema 4D, 280
combining projects, 13–14
composition settings for, 21–22
composition setup for, 6–8
consolidating projects, 13–14
context-clicks for, 11
deep image, 415–416
fields in, 18–19
Find Missing Footage in, 11–13
frame rates in, 18
importing sources of, 8–10
Interpret Footage for, 15–16
introduction to, 2
keyboard shortcuts for, 11

moving projects, 13–14
multiprocessing of, 25–26
nesting, 102–103
organizing sources, 8–10
output of, 30–33
pixel aspect ratio in, 6, 15, 18–19
plug-ins for, 29–30
precipitation in, 430–431
previewing of, 27–29
Project Settings for, 15
pulldowns in, 19
quality of, 22–24
Render Queue settings for, 30–33
resolution of, 22–24
responsiveness of, 24–26
save options, advanced, 14–15
selections for. See selections
settings for, 15–22
shadows in. See shadows
source formats in, 20–21
user interface for, 22–29
workspace setup for, 3–5
Composition area, Render
Settings, 30
composition markers, Timeline, 38
Composition Settings
Advanced tab of, 59, 109–110
for composites, 22
for motion blur, 59
numbering frames in, 15
Composition viewer, 11, 84–85
compositions. See composites
Compound Blur
for diffraction effect, 421
features of, 447
for fire, 447
for smoke trails and plumes,
426–427
compression
artifacts, 214, 312
chromatic, 182
in final output, 33
low resolution of HD due to, 318
noise suppression for heavy, 183
of proxies, 120
in QuickTime, 375
of source formats, 21
concatenation, 110
conditional events, 332–336
Confidence settings, 254–255
consolidating projects, 13–14
context-clicks, 11
continuous access, 115–118
contrails, 426–427
contrast
by altering light direction, 384
for clarity in mattes, 165
in color-to-grayscale conversion,
394
in Curves, 139–145
in daylit scene, 437

in depth cues for particulate
matter, 413
in hi-con mattes, 166–170
in Levels, 130–134
in ordinary lighting, 150–151
reality distortion with, 313
in Refine Edge brush, 212–213
in Roto Brush, 210
for wispy smoke, mist, or fog, 419
Convert Vertex, 217–218
coordinate systems, 340
copy and paste
animation, 50–51
masks, 91
core mattes
closing holes in, 193
in color keying, 177–178
defined, 162
refining, 192
rescuing chewy matte, 188
Corner Pin tracking, 251, 256, 259, 262
costume contamination, 185
crashing of After Effects, 125
Create Camera, 231, 287
Create Orbit Null, camera, 279
Create Stereo 3D Rig, camera, 279
cropping
4:3 image for widescreen
format, 317
in Warp Stabilizer VFX, 241
CRW file format, 21
.cube format, 378, 379
current time, in RAM preview, 27
Curves control, 139–145, 428–429
Custom Look layers, 389, 391
Cycle Mask Colors, 88–89, 215
cycloramas, 198

D
darkening
with Add or Multiply mode, 94
masks, 89
in multipass renders, 407
date column, in Project panel, 13
DaVinci Resolve, 162
The Day After Tomorrow, 39, 424, 430
day for night, in SpeedGrade,
394–395
Deactivate Live Update, 24
debris
animating bullet, 438
for chunky explosions, 452
in light saber methodology, 442
Decontamination, 188–189
decrement method, for values, 39
decrement operator (--), in
JavaScript, 332
deep images, 415–416
Defocus layer, Camera Lens Blur, 301
delay, time, 329
deleting expressions, 325
delta, defined, 182
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density, 88, 132, 357
depth cues, 414–416
depth maps, 414–416, 452
depth of field
in 3D compositing, 299–301
for bokeh blur, 296–298
in cameras, 272
deep compositing and, 415–416
in multipass 3D compositing, 408
optics and edges of objects, 79
Despill Bias, 181
Despot cleanup tools, 183
Detailed Analysis, Warp Stabilizer
VFX, 243
Difference
blending mode, 95
mattes, 170
diffraction. See Compound Blur
Diffraction Fringe, 303
Diffuse layer, 407
diffuse lights, on sets, 198–199
diffuse (soft) light, 383
digital cameras, 354–355
digital film, color options, 357–359
Digital Lighting & Rendering, Second
Edition, 405
Digital Video and HDTV Algorithms
and Interfaces, 360
dimensionality, 449–450
direction of light, 384
Directional Blur, 61
disk caching
attached storage for, 114–116
Cache Work Area in Background
in, 103, 115
as Global Performance Cache, 113
in persistent disk cache, 115–118
Disney Animation, 69, 214
displacement
for fire, 447
for heat distortion, 443–446
distance
depth cues for particulate
matter, 414
depth maps for planes of,
414–416
falloff, 385
distortion
after stabilization of shot, 239,
243
for billowing smoke, 422–424
with chromatic aberration,
315–316
emulating real camera, 273
heat, 443–446
lens, 273, 275–278
with lens artifacts, 313
with lens flare, 313–314
understanding, 312–313
with vignette, 315
Distortion Mesh property, 423
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dot notation hierarchy, of
expressions, 327
DPX file format
Cineon Log in, 356
output, 372–373
as source format, 20–21
drop shadows, 402–403
Dropbox, 123
DSLR cameras
dynamic range of, 356
Keylight and, 196–197
recording reference data, 273
shooting for stabilization, 244
duplicate layer, 98
duration
Paint menu setting, 222–223
in Project panel, 18
setting up composition, 6
dust busting, 226
The DV Rebel’s Guide: An All-Digital
Approach to Making Killer Action
Movies on the Cheap, 312, 435
Dynamic Link
Cineware comparison to,
279–280
optimizing projects with, 117–118,
122
dynamic range. See also HDR (high
dynamic range)
advanced color and, 354–356
in Beam effect, 440
digital image limitations and, 350
high. See HDR (high dynamic
range)

E
Ease Curves, 293
ease( ) method, 342–343, 345
Easy Ease, 45–46, 50
Easy Rider, 313, 397
Ebberts, Dan, 106
edge mattes
for bluescreens, 177–179
customizing, 95
edge selection with, 193–194
refining, 183
rescuing chewy matte, 188
edge multiplication, 81–84, 96–97
edges
of bitmap alpha, 78
blurring of frame, 302
color correction in Keylight, 178
feathered alpha for, 78–79
fixing banding in, 352
fixing blur map for, 305–306
fringing of, 82–83
Guess option for, 82
importing correctly, 82–83
Interpret Footage for, 81–83
introduction to, 78
opacity of, 80

premultiplication of, 81
protecting on mattes, 166
Refine Edge for, 210–214
Remove Color Matting for, 83–84
of selections, 78–84, 193–194
Synthesize Edges for, 241–242
transparency of, 81–84
troubleshooting, 83–84
editing
expressions, 325
mask shapes, 85
effects
in 3D Camera Tracker, 231–233
Beam, 440–443
Black & White, 392–395
blur, 402
CC Lens, 326, 431
CC Light Rays, 401
Channel Combiner, 84, 182–183
Compander, 369–370
in composites, 29–30
energy, 439–443
Exposure, 273, 447
Extract, 166–168
fine-tuning Refine Edge brush,
212
Fractal Noise, 427, 448
Grow Bounds, 108–109
Lens, 326, 431
light saber, 439–443
muzzle flash, 435–436
Noise, 308
Optics Compensation, 276–278
Ramp effect, 304, 308
Red Giant Corner Pin, 262
Refine Soft Matte, 185–190
Remove Color Matting, 83–84
resetting, 132, 135–136
for selections, 77
Separate RGB, 316
Shatter, 452
Simple Choker, 168, 178
Spill Suppressor, 178–179
Star Wars light saber, 440–443
support for 16-bpc, 351
tilt-shift lens, 304–305
Timecode, 16
Trapcode Lux, 397, 399, 401
Turbulence Displace, 427
Turbulent Noise, 419–421
Effects & Presets panel, 5, 29–30
Ellipse tool, 315
embedded timecodes, 16
Emitter, 429
encoding
log, 358–359
video gamma, 360–361
energy effects, 439–443
environment
ambient motion in, 425–427
billowing smoke in, 422–424
depth cues for, 414

Index
depth maps for, 414–416
fog, smoke, and mist in, 419–422
infinite depth in, 418
Liquify effect for, 424
Mesh Warp for, 423
overview of, 412
particulate matter in, 412–416
plumes in, 426–427
precipitation in, 427–431
sky replacement in, 416–418
smoke trails in, 426–427
wet look in, 428–429
wind in, 425–427
Eoin, Marcus, 322
EPIC cameras, 369
Eraser, 221
Erodilation, 193
Error Threshold, 67
Evolution animation, 419, 421
Excel spreadsheet, 50
Expansion settings, Mask Feather,
220
explosions
bullet-hit, 438
creating effect of, 425–426
muzzle, 436
in pyrotechnics, 450–452
exporting, camera data, 282–283
Exposure effect
creating fire, 447
emulating real camera for, 273
for storms, 429
exposures, for HDR images, 355–356
Expression Language menu, 324
expressions
additional information for, 348
color sampling in, 346–347
from comp space to layer surface
with, 345–346
conditional events in, 332–333
controls for, 343
conversion in, 346–347
copying, 325
creating, 324–325
deleting, 325
disabling, 325
editing, 325
effect tracks parented layer,
341–342
exposing, 325
interpolation methods in,
343–345
language of, 326
layer’s index for, 328–330
limitations of, 323
linking effect parameters to
properties with, 326–328
linking mask shapes with, 221
looping keyframes with, 330–332
playing only frames with markers,
335–336

random distribution and,
339–340
random time in, 338–339
for randomness, 335–340
reducing opacity with, 345
reducing saturation away from
camera with, 342–345
time delay and, 329–330
tracking data with, 252
tracking motion between 2D/3D,
339–346
triggering animation at markers,
334–335
understanding, 322–323
wiggle time in, 337–338
EXR (EXtended Range) file format
32-bpc color output, 373
defined, 21
multipass rendering via, 407
OpenEXR format, 370
Extract effect, 166–168

F
f-stop settings
in 3D compositing and focal
depth, 300–301
in color keying, 200
emulating real camera for, 273
matching existing footage, 300
recording camera lens data,
273–274
F9 keys, 45
fabricated explosions, 449–450
fades, 345
falloff, light, 384–386
Fast Blur
in Beam effect, 440
in edge selection, 194
in heat distortion, 445–446
for light wrap, 396
in native video space vs. linear
space, 365
for storms, 429
working with, 402
Fast Draft, 25
feather
in Mask Feather. See Mask Feather
in Refine Edge brush, 212–213
in Refine Soft Matte, 188–189
in Roto Brush, 210
in Synthesis Edge Feather, 242
feathered alpha edges, 78–79
feathered masks, 392, 420–421
feature regions, in point tracker,
249–251, 253–254
Field of View (FOV) value, 276–278
fields, 18–19
file formats
Cineon, 353
source, 20–21
widescreen, 316–317

file name templates, 119
film
and Cineon files, 353–354
density, 357
dynamic range of, 354–356
Film Size, 271
filtering, in Timewarp, 69
Final Result, 175–176, 178, 184
Find Edges, 193
Find Missing Footage, 12
fire. See also pyrotechnics; smoke
blending modes for, 447–448
dimensionality in, 449–450
elements for, 446–447
explosions of, 450–452
heat distortion for, 443–446
light interactions for, 448
understanding, 446
firearms
creating shots with, 434–435
hits and squibs from, 438–439
muzzle flash and smoke from,
436–437
shells and interactive light
from, 437
the shoot for, 435–436
First Vertex, 91, 217–218
fish-eye lens shots, 276–278
fixed (prime) lens, 272, 398
flares, 314–315, 397–398
flashes, 442–443
Fleischer, Max, 121
floating point files
decimal numbers, 355–356
formats, 370
HDR compositing and, 366–367
Flowchart view, 53–54
focal depth
3D compositing and, 299–301
and bokeh blur, 296–298
Focal Length, 272–275
fog, 419–422
folders, for project items, 104
foot room, 138
Force Alphabetical Order, 10
foregrounds
in 3D Camera Tracker, 234–235
altering light direction in, 384
in depth cues, 414
in depth maps, 414–416
effect of camera zoom on, 292
isolating object/plane in,
244–245
in light wraps, 396
for lighting on sets, 198–200
matching background color to.
See matching colors
in point stabilization, 247–248
refining grain settings for,
308–310
in sky replacement, 416–418
smoky or misty, 420
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Index
Fractal Noise effect
for dissipating contrails, 427
for smoke, 448
for wispy smoke, mist, or fog,
419–421
Frame Blend, 63
Frame Mix, 63–66
frame rates
in Cinema 4D, 280
in composites, 6, 18
distorting reality with, 313
preserving, 110
and realism, 316–317
for soap operas/reality TV, 316
timing and retiming, 62–64
framing layers, in Timeline, 56
free-transform box, 217
Free Transform mode, 85
Freeze Frame, 63, 65
fringing, 82–83, 184
fromCompToSurface( ), 345–346
ft-Cubic Lens Distortion, 315
Full Range preset, Cineon files, 359
full resolution, 207
Furnace User Guide, 67
Fusion ioFX, 116

G
gamma adjustments
with Curves Control, 139–145
in dramatic lighting, 154–157
in Hue/Saturation, 146
in Levels, 133–134
in QuickTime, 375
gamma encoding, 360
gamma exposure slamming, 160–161
garbage mattes (gmattes)
in closing holes, 193
in color keying, 172
for holdout mattes, 190
in Keylight, 177
procedural, 190–192
in sky replacement, 418
Gaussian Blur, 402
Gaussian random expressions, 336,
339
glass elements, in lens flare, 314–315
glass, shattering effect for, 452
glints, from reflected light, 399
Global Performance Cache
attached storage in, 116
Global RAM Cache in, 113–115
memory acceleration in, 114–115
optimizing projects with, 113–114
persistent disk cache in, 115–118
Premiere Pro’s Dynamic Link in,
117–118
Global RAM Cache, 113–115
glows, 448
gmattes. See garbage mattes
(gmattes)
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God rays (volumetric light), 399–400
GPU, for SpeedGrade, 387
gradient backgrounds, 28
grading shots. See SpeedGrade
grain
Bias settings increasing, 181
bokeh blur and. See bokeh blur
introduction to, 307
low scene light triggering, 307
management strategies for,
307–310
removal of, 310–312
Graph Editor
basic animation in, 44–45
Ease Curves in, 45–46
Easy Ease in, 45–46
Hold keyframes in, 49–50, 52
layer bar mode vs., 51–52
Linear keyframes in, 44
overview of, 42–43
separating XYZ in, 46–48
Show Properties in, 43
Show Reference Graph in, 44–45
Snap button in, 48
summary of, 50
transform boxes in, 48–49
view in, 44–45
Graph Options menu, 44–45, 48
graphics cards, 114
gray
for blur maps, 303–306
in color correction, 132–133
in color keying, 164, 174–175,
182, 194
for compositions in Flowchart, 53
matching, 148
in overlay and light modes, 94
suppressing color spill to, 195
for transparency in mattes, 73
grayscale
in depth maps, 415
in mattes, 73
in multipass renders, 409
green channel. See also RGB (red,
green, blue)
in chromatic aberration, 316
in color matching, 135–136, 150,
153–158
in heat distortion, 446
in noise suppression, 183
refining grain with, 308
greenscreens
bluescreens vs., 171–172
in color keying, 171–179
fine-tuning image quality, 185
fringing and choking in, 184
Life of Pi using, 268
removing grain from, 311
Screen Balance for, 181
shooting, 196–197
suppressing color spill and, 195

Grid layer, 277–278
ground planes, in 3D Camera Tracker,
231
Grow Bounds effect, 108–109
Guess option, Interpret Footage, 82
guide layers, 104, 112

H
hacking shortcuts, 124
Hand tool, 24
handles, in Synthesize Edges,
241–242
hard (direct) light, 94, 383
HDR (high dynamic range)
16-bpc composites, 351–352
Cineon files, 353–354
Cineon Log space, 356–359
digital film, 357–359
dynamic range, defined, 354–356
film, 353–354
linear compositing in. See linear
HDR compositing
linearized working space and,
361–363, 366–367
source images, 366–367
video gamma space, 360–361
heat distortion, 443–446
hi-con (high-contrast) mattes
for bullet-hit explosions, 438
linear keyers and, 166–170
for storms, 429
Hide Layer Controls, 28
high dynamic range. See HDR (high
dynamic range)
highlights
for billowing smoke, 422
Camera Lens Blur for, 302
light direction for, 384
for muzzle flash, 437
histograms
adjusting Levels with, 129
channels and, 136–138
in Extract, 166–168
for problem solving, 134, 138–139
hits, bullet, 438
The Hobbit, 316
Hold keyframes, 49–50, 52
holdout mattes
adding in mocha AE, 262
in color keying, 190–191
deep image compositing
replacing, 415–416
in Keylight, 179
in Liquify, 424
hot look, 440–443
hotspots, 384
HSB (Hue, Saturation, and
Brightness). See also
Hue/Saturation
blending modes for, 95
Hue/Saturation control for, 146

Index
HSLA (hue, saturation, lightness, and
alpha) color space, 347
Hue/Saturation
in edge selection, 194
ineffective for black and white
images, 393
matching colors with. See
matching colors
reducing saturation in, 394
for storms, 428–429
suppressing color spills with,
195–196
understanding, 145–146

I
ICC color conversion, 357
Identifier, 370
idx variable, 336
If It’s Purple, Someone’s Gonna Die, 318
if statements, 332–336
Illustrator, 15
image layers, 112, 311
image quality, 353
image sequences, 8–10
Imagineer, 256
Immigration, 10
Import & Replace Usage, 119
importing
composite sources, 8–10
Maya scenes, 263–265
MochaImport for, 259
as post-render option, 119
selections, 82–83
for sharing camera data, 282–283
in-between animation, 214
Incidence passes, 407
The Incredibles, 307
Increment and Save, 14–15
increment method, values, 39
index attribute, 328–330, 332
indirect light, 404
Industrial Light & Magic, 370
infinite depth, 418
Info panel, 4–5, 33
Input Black/Input White
creating fire, 447–449
individual channels for color
matching, 135
in Levels, 130–133
in RGB histograms, 136–139
interactive light
in Beam effect, 442
for fire, 447–448
gunshells and, 437
interlaced footage, 18–19
Intermediate Result, in Keylight,
175–178, 184, 188
interpolation methods, 343–345
Interpret Footage
in composites, 15–16
for edges, 81–83
overriding all settings with, 20

Intersect mode, for masks, 88–89
Inverse Square Clamped lights,
385–386
iPhones, shooting for stabilization,
244
IRIDAS .cube LUT, SpeedGrade, 391
IRIDAS FrameCycler, 9
isolation
solving light characteristics, 384
in Warp Stabilizer VFX, 245–246

J
Jacob’s Ladder, 337–338
JavaScript, 326–328, 330, 332–336
JPG file format, 21

K
Keep Colors, Linear Color Key, 170
Key Color eyedropper tool, 169
keyboard shortcuts
16-bpc color, 150
Add to Render Queue, 7
adding images, 6
Adjust Tension pointer, 218
adjustment layers, 110
alpha channels, 136
Alpha Overlay/Alpha
Boundary/Alpha view, 209
animated masks, 90–91
animation, showing/hiding
paths, 47
background, duplicating/
deleting effects in, 428
background, eliminating within
selection, 208
backgrounds, 28–29, 165
Bezier masks, 86
Brush tool, 222–223
closing multiple compositions,
105
color channels, 29
color channels, flipping
through, 308
column views, 37
composites, 11
composition markers, 38
Composition viewers, 105
Corner Pin tracking, 262
Deactivate Live Update, 24
Easy Ease, 45–46
Effects & Presets panel, 5
expressions, 324
Find Missing Footage, 11
Flowchart view, 53–54
frames, selecting more than
one, 10
framing layers, 56
full resolution, 206
grading shots, 389–390
Graph Editor, 43
grids, 28

Hand tool, 24
Hold keyframes, 49
Import Multiple Files, 4
inserting selected items at top
layer, 40
Interpret Footage, 81
keyframe navigation/selection,
54
keyframe offsets, 55
keyframes, optimum handling
of, 216
layer/composition markers, 38
layer duplication, 98
layer positioning, 6
layers and composition
markers, 38
layers, hiding controls, 28–29
layers in Timeline, 39–41
layers, locking, 38
mask keyframe settings, 90
mask shapes, 85
mattes, clarity in, 165
maximizing screen, 9
Miniflow view, 105
in mocha AE, 262
motion blur, 59, 255
noise suppression, 183
Null Objects, 57
parent layers in Timeline, 57–58
Pen tool, 217
precomping, 103
Preferences, resetting, 124
previewing composition, 7
Project Settings, 15
quickly change display
resolution, 23
raising project color depth, 352
Refine Edge brush, 211
Reload Footage, 11
Render Queue, 7, 30
responsiveness, 24–25
RGB Straight, 83
Roto Brush, 207, 209
rulers, 28
Shape layers, 87
Shape Path Visibility button, 29
Shape tools/layers for, 87
Shift+RAM Preview, 27
Show Cache Indicators, 115
Show Channel, 29, 135–136
Show Grid, 28
Show Rulers, 28
SpeedGrade, 389
switching to 16 bpc color, 139
time navigation, 39
Time Remap, 64
Time Stretch, 63
in Timeline, 39–42
Title/Action Safe, 28
Toggle Mask, 29
Tools panel, 4
transform boxes, 48–49
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keyboard shortcuts (continued )
Transform controls, 42
Trim Comp to Work Area, 40
undocking panel, 7
View Options, 29
zoom, centering, 181
zoom in and out, 24
KeyedUp, 125
keyframe assistant, 326
keyframes
adding points to, 215
for articulated mattes, 214–218
copying and pasting data, 50–51
created by Disney animators, 214
in layer bar mode vs. Graph
Editor, 51–52
looping, 330–332
offsetting values of multiple, 55
optimum handling of, 216
rotoscoping masks, 215–217
Roving, 51
in Timeline, 42–50
Keylight
Bias settings in, 181
Clip Rollback in, 183
Clip White/Clip Black in, 182
evaluating full motion shot
in, 179
first passes in, 173–174
garbage mattes in, 172–173
keying footage with, 171–173
Linear Color Key vs., 169
matte choke in, 184
multiple passes in, 177–179
noise suppression in, 183
overview of, 180
refinement in, 181
refining mattes in, 174–176
Screen Balance in, 180–181
Screen Gain in, 180
Screen Grow/Shrink in, 184
Screen Softness in, 183
spill suppression in, 184–185
KeyTweak, 221
Kino Flo lights, 198
Kluge paper feeder, 365
Knoll Lens Flare, 398–399
Knoll Light Factory, 314
Kodak, test image, 353
Kr3d files, RED, 197
Kronos, retiming tool
in Pixel Motion, 64
as stand-alone plug-in, 65
in Timewarp, 65–69

L
la nuit américaine, 394
language, of expressions, 326
laptops, time navigation for, 39
Lawrence of Arabia, 317
Layer Control, 343
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Layer panel
anchor points in, 56
brush tools only operating in, 222
color keying in, 173–174
Freeze button in, 214
mask feather in, 220
mask options in, 84
new mask shape to replace target
mask, 91
paint tools in, 222
Refine Edge stroke and, 212
Roto Brush tool in, 207, 209
timecode/frame display in, 329
tracker feature in, 249
tracking with, 249
View menu in, 225
Warp Stabilizer in, 247
Layer/Source, in Timeline, 37
layer space transforms, 339–341
layer surface, 340, 345–346
Layer Tagger, 38
Layer viewer, masks, 84–85
layers
adjustment, 110–111
anchor points in, 56
combining, 72–77
controls in Timeline, 39–41
creating grain with Noise, 308
Custom Look, 389, 391
diffuse, 407
framing, 56
guide, 112
index attribute for, 328–330
“liquid” 2D, 421
locking, 37
markers in Timeline, 38
Parent hierarchy in Timeline,
57–58
precomping to optimize number
of, 103
Shape, 87–88
sharing data in Cinema 4D,
283–284
Layers panel, SpeedGrade, 391–392
LDR compositing, linear, 373–379
lens
settings, 270–272
tilt-shift effect, 304
lens artifacts, 273, 312–313
lens data, 273–275
lens distortion, 273, 275–278
Lens effect, 326, 431
lens flare
chromatic aberration in, 316
from comp space to layer surface,
345–346
effect, 398
for fire, 448
light sources of, 398
by physical camera, 313–314
in SpeedGrade, 397–398

Levels
brightness controls in, 133–134
channels for color matching in,
135–136
color-matching in, 150–151,
153–157
contrast adjustments, 130–133
Curves control vs., 139
in edge selection, 194
histograms and channels in,
136–139
Input Black/Input White in,
130–133
integrating foreground/
background elements with, 148
Output Black/Input White in,
130–133
resetting, 132
for storms, 429
understanding, 129–130
viewing color percentages in, 153
Life of Pi, 268
light
in After Effects, 392–395
altering direction of, 384
backlighting, 396–397
in chromatic aberration, 315–316
and color. See light
color-matching in dramatic,
153–157
color-matching in ordinary,
149–153
effect on film, 357
falloff, 384–386
flares, 397–398
gunshells and interactive, 437
in heat distortion, 443–446
hotspots, 384
interactive, 448
in lens flare, 314–315
location of, 383
in multipass 3D compositing,
404–409
for muzzle flash, 437
overview of, 382
quality of, 383
reflected, 399
scattering of, 399–401
shadows, 401–404
sharing camera data and, 283
solving wrong position/direction
with, 159–160
in SpeedGrade, 387–392
volume of, 399–401
wrapping, 396–397
Light blending modes, 94
Light Burst 2.5, 342
Light layer controls, 385
Light Rays effect, 401
light saber (Beam) effect, 440–443
Lighten mode, masks, 89

Index
lighting
color keying and, 185
excessive grain from low
scene, 307
on set, 198–200
lightning, 443
linear blending
Add mode with, 92
adding realism with, 367
Blend Colors Using 1.0 Gamma
for, 92, 370–371
for fire, 447
for LDR footage, 371
without 32-bpc HDR, 366
Linear Color Key, 166–167, 169–170
linear, defined, 360
linear gradients, 140, 142
linear HDR compositing
32-bpc in, 367–369
blending colors with 1.0 Gamma
in, 370–371
Compander in, 369–370
introduction to, 363–366
linearized workspace for,
366–367
mixed bit depths in, 369–370
linear interpolation, 343–345
linear keyframes, 44, 50
linear LDR compositing, 373–379
linearized working space
choosing, 374
HDR source and, 366–367
understanding, 361–363
Link Focus options, 279
linking effect parameters to
properties, 326–328
“liquid” 2D layers, 421
Liquify effect, 424
Live Update, 24
LME (Local Motion Estimation), 67
Load Project or Template at
Startup, 105
location of light, 383
Lock icon, 105
locking
layers, 37
shots, 239, 246, 290, 294
source time, 224
log encoding, 358–361
logarithmic curves, 353, 356–359
.look files, 379
Look tab, SpeedGrade, 389
look-up tables. See LUTs (look-up
tables)
Looks plug-in, for color, 386
Looks, Red Giant software, 162
loopIn( ), 330–332
loopInDuration( ), 331–332
looping keyframes, 330–332
loopOut( ), 330–332
loopOutDuration( ), 331–332
loops, Ram preview options, 27

lossless compression, TIFF, 21
Luma Inverted Matte, 97, 415
Luma Key, 167
luma mattes
altering light direction with, 384
applying grayscale maps as,
407–408
applying particle layers as, 420
applying to adjustment layer, 194
defined, 96, 406
depth maps for, 415
in edge selection, 194
for fabricated smoke or mist, 420
in heat distortion, 446
in Luminescent Premultiply,
96–97
for sky, 418
for storms, 428
in Track Matte menu, 97
for wet look, 428
luminance
chroma subsampling and, 182
correcting in Timewarp, 67
Extract effect for, 166–168
Luminescent Premultiply, 96–98
LUTs (look-up tables)
applying to Cineon logs, 358–359
ARRI LogC and, 379
color management in, 374–375
overview of, 377–379
SpeedGrade presets, 391
LZW lossless compression, TIFF, 21

M
.ma files (Maya) scenes, 263–265
Mac OS X
crashing of After Effects on, 125
gamma value in, 360
revealing User/Library folder
in, 124
Magic Bullet Colorista, 162
Magic Bullet Looks, 315
mapping, camera, 294–296
Marcie (Kodak test image), 353
markers
for conditional events, 332–333
play only frames with, 335–336
triggering animation at, 334–335
Mask Expansion tool, 85
Mask Feather
refining mattes with, 218–220
selections, 85
for vignettes, 315
Mask Interpolation, 91
Mask Path keyframes, 220
masks
Add mode for, 88–89
Add with Invert mode for, 88–89
animated, 90–91
Auto-trace for, 76
Bezier, 86
combinations of, 87–90

copying, 76, 91
density of, 88–89
for fabricated smoke or mist,
420–421
First Vertex for, 91
for fog, 420–421
linking with expressions, 221
Mask Feather, 85
for mist, 421
mocha shape, 86
modes of, 88–90
moving, 91
moving through mist, 421–422
opacity of, 88
options for, 84
overlapping inverted layers, 90
overlapping issues of, 88–89
overview of, 74–76
pasting, 91
Roto Brush, 74–75
rotobezier shapes for, 217–218
rotoscoping, 215–217
Shape tools and layers for, 87
in SpeedGrade, 391–392
Subtract mode for, 88–89
tracking and translating, 220–221
Match Grain tool, 307–310
Match Legacy After Effects
QuickTime Gamma Adjustments,
376–377
matching colors. See color matching
matching composition settings,
30–31
Matching Softness, 169
Matching Tolerance eyedropper
tool, 169
Material Options, 295
Math.min(), 335–336
matte choke, 184, 191–192
mattes
adding Refine Edge to, 210–214
Alpha/ Alpha Inverted, 97
alpha track, 311, 403
articulated, 214–217
avoiding chewy, 166, 185–190
core. See core mattes
creating with Roto Brush,
206–210
defined, 73
Difference, 170
edge. See edge mattes
garbage. See garbage mattes
(gmattes)
hi-con, 166–170, 429, 438
holdout. See holdout mattes
luma. See luma mattes
Luma Inverted Matte, 97, 415
overview of, 73
procedural, 164–166
Refine Matte, 179, 306
Refine Soft Matte effect, 185–190
refined, 218–221
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mattes (continued )
screen, 180
spreading, 193
track. See track mattes
Maxon Cinema 4D, 280–282, 289
Maya (.ma) files
3D tracking data for, 263–265
camera integration for, 263
editing preferences, 124–125
Pixel Cloud for, 384
rendering tips, 10
Media tab, SpeedGrade, 387–388
Mediacore, 20
memory
acceleration, 114–115
adjusting in multiprocessing, 26
Throttle-n-Purge controlling, 126
Merge command, 282–283
Merge Projects script, 14
Merge to HDR Pro, Photoshop,
355–356
mesh distortion tool, Liquify as, 424
Mesh Warp, 422, 423
methods, dot notation hierarchy
for, 328
midtones. See gamma adjustments
Midtones tab, SpeedGrade, 388–390
miniatures, exploding, 449–450
Miniflow view, 53
Minimal workspace, for composites,
4–5
Minimax, 191, 193
Mirror Blend control, 226
Missing Effects, finding, 12
Missing Footage, finding, 11–12
mist, 419–422
mocha AE planar tracker
basics, 257–260
Copy/Paste selection tool, 76
nitty-gritty of, 260–262
tracking matte selection, 221
understanding, 256–257
mocha shape, 76
MochaImport, 259
mochaPro, 256
Mode setting, paint strokes, 222
monitor color, 351
monitor-referred values, 361
Monitor tab, SpeedGrade, 387–388
monitors
converting Cineon files to color
space of, 353
as nonlinear, 360
Ram preview options, 27
setting up workspace, 9
SpeedGrade requirements, 387
moon shots, 397
motion blur
in 3D Camera Tracker, 236
accurate, 58–59
avoiding unwanted, 244
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decoding, 59–61
emulating real camera for, 272
enhancement, 61–62
HDR images in linearized
workspace and, 366–367
in light saber methodology,
440–442
in mocha AE, 259
in motion tracking, 254–256
in native video space vs. linear
space, 363–365
for precipitation, 430
Refine Edge brush with, 213
refining mattes with, 220
in Timewarp, 66
Warp Stabilizer and, 239, 243
motion path, in camera animation,
292
motion tracking
between 2D and 3D, 339–346
3D Camera Tracker for, 231–236
camera integration for, 263–265
for composite precipitation,
430–431
introduction to, 230
mocha AE planar tracker for,
256–262
point tracker for. See point tracker
Warp Stabilizer for. See Warp
Stabilizer VFX
moving projects, composites, 13–14
multipass 3D compositing, 404–409
multipasses, in Keylight, 177–179
Multiply blending mode
Add mode vs., 419
creating wispy smoke, mist, or
fog, 419
defined, 94
in multipass renders, 407
multiprocessing, 25–26
multithreading, 25
muzzle flash effect, 435–437

N
name templates, files, 119
naming conventions
brush strokes, 223
brushes in Brush Tips panel, 223
projects and renders, 34
source files, 7
navigation, in Timeline, 39–41
nearestKey( ), 332
Neat Video, 310
negatives, film, 357–359
nested compositions, 64, 103,
105–108
nested time, 108–110
network rendering, 122–123
No Motion, in Warp Stabilizer VFX,
239
nodal pans, 418

noise
grain and, 307–311
Perlin, 337
suppressing in Keylight, 183
None mode, for masks, 89
nonlinear response to color, 360–361
Normal passes, 384
Normality, 407
normalized pixel values, 91
Nudge controls, mocha AE, 259
null objects
applying track data to, 253
in Cinema 4D Lite, 288–290
in Maya scene, 264–265
sharing camera data, 283
numbering
color values, 352
for comp template, 104
in composition, 15
fields for Camera Settings,
271–272
lens length, 270–271
sliders for Levels, 129

O
occlusion, in multipass setup,
407–408
on set, shooting, 196–200
opacity
of adjustment layers, 111
of colors in expressions, 346–347
of edges, 80
for fades, 345
for HSB blending modes, 95
in light wraps, 397
of masks, 88, 220
of mattes, 73
in multipass renders, 407
of vignettes, 315
OpenEXR, 370
OpenSesame, 16, 125
Optical Flares, 398–399
Optics Compensation effect, 276–278
optics, in AE camera. See camera
optics, mimicking natural behavior
of, 78–80
optimizing projects
adjustment layers for, 110–111
Adobe Media Encoder for, 121
advanced composition settings
for, 109–110
aerender for, 122
attached storage for, 114
background renders for, 121–123
Cache Work Area in Background
for, 103, 115
Collapse Transformations for, 108
composition nesting for, 102–103
continuous access for, 115–118
Dynamic Link for, 117–118, 122

Index
Global Performance Cache for,
113–114
Global RAM Cache for, 113–115
guide layers for, 112
hacking shortcuts for, 124
memory acceleration for, 114–115
nested compositions for, 103,
105–108
nested time for, 108–110
network rendering for, 122–123
persistent disk cache for, 115–118
post-render options for, 119
pre-renders for, 119–121
precomping for, 102–103
precomping issues, 106–109
preferences and project settings
for, 124–125
previews for, 118–119
Project panel for, 103–105
proxies for, 119–121
render pipelines in, 113
render speed in, 118
Shortcuts file in, 124
space management for, 107–108
Sync Settings for, 125–126
time management for, 107–108
Timeline management for,
105–106
Watch Folder for, 123
Orientation, in 3D Camera Tracker,
231–232
origin point, in 3D Camera Tracker,
231
Output Black/Output White
in depth maps, 415
in Levels, 130–133
in RGB histograms, 136–139
Output Modules, 31–33
output, of composites, 30–33
over-range values, 353, 355, 359
Overall tab, in SpeedGrade, 388–390
Overlay blending mode, 94
overriding composition settings,
30–31

P
Paint
cloning in, 221–226
dust busting in, 226–227
guidelines for, 204–205
with Refine Edge brush, 210–214
in reverse stabilization, 246–247
with Roto Brush, 205–210
rotoscoping and. See Paint
wire/rig removal in, 226
Pan Behind tool, 55–56
Panel menu, 11
panoramas, 316–317
PAR (pixel aspect ratios), 6, 18–19

parallax
in fire composites, 449–450
pan in 3D tracker lacking, 234
in sky replacement, 418
in smoke, fog, or mist, 420–422
in tracking rotation and scale, 252
Warp Stabilizer and, 237
parent hierarchy
in animation, 57–58
in Timeline panel, 37
parented layer, effect tracks, 341–342
parenthesized comps, 108
Particle Playground, 428, 445
Particular
for composite precipitation,
430–431
for precipitation, 427, 429–430
for smoke trails or contrails,
426–427
particulate matter
creating heat distortion, 443–446
depth cues for, 414–416
depth maps for, 414–416
in environment, 412–416
for smoke trails or contrails,
426–427
for smoky or misty foreground,
420
for wispy smoke, mist, or fog, 419
Pen tool
for Bezier masks, 86
for Bezier motion path, 50
for rotobezier shapes, 217
Perlin noise, 337
persistent disk cache, 115–118
PF track, 38
Photoshop
backwards compatibility of, 15
Clone Stamp tool in, 422
for composites, 6, 21–22
Curves control in, 140
Merge to HDR Pro in, 355–356
paint tools, 221–222, 226
Photoshop file format (PSD), 21–22,
374
pick whip, in expressions, 324,
326–327
PID number, forcing crash on
Mac, 125
Pixar movies, 307
pixel aspect ratios (PAR), 6, 18–19
Pixel Cloud, 384
Pixel Motion, 63–67
Pixel Motion Blur, 62
plates, 3, 129
Play button, in Tracker panel, 250
plug-ins
16-bpc, 351
Cinema 4D, 279
Colorista, 162, 386
for composites, 29–30

RE:Map, 405
Silhouette, 226
for transparency, 77
plumes, 422, 426–427
PNG file format, 20–21
Point Control, 343
point of interest, 291
point stabilization, 247–248, 250
point tracker
Confidence settings in, 254
mocha AE planar tracker vs., 256
motion blur in, 254–256
nulls in, 253
positioning in, 252
rotation in, 252
scale in, 252
selecting features in, 249–251
tricky features in, 253–254
tweaking tracks in, 251–252
understanding, 249
points, in articulated mattes, 214–217
pollution. See particulate matter
Position keyframes
in 3D Camera Tracker, 231–232
repositioning anchor point
without changing, 56
in Timeline, 43–44, 46–48
Position Pass, with Pixel Cloud, 384
position values, 251–252
post-render options, 119
Posterize Time, 64
postexpression value of property,
323
Pre-compose, 103
pre-rendering
in mocha AE, 260
in project optimization, 119–121
precipitation
composite, 430–431
creating, 429–430
understanding, 427–428
in wet look, 428–429
precomping, 102–103, 106–109
Preferences
adding points to keyframes, 215
changing default frame setting in
Roto Brush, 208
editing, 124–125
Sync Settings for, 125–126
Premiere Pro’s Dynamic Link, 117–118
premultiplication, 81–84, 96–97
Preserve Frame Rate, 110
Preserve Resolution When
Nested, 110
Preserve Underlying Transparency,
95–96
presets
keyframe transition types, 50
Paint brushes, 222
in SpeedGrade, 391

465

Index
Preview panel
combining with Info panel, 5
composites, 27–29
maximizing screen in, 9
RAM Preview settings in, 23, 27
previews, in project optimization,
118–119
primary animation, 425
Primary controls, SpeedGrade,
389–391
Primatte keyer, 201
prime (or fixed) lens, 272, 398
procedural garbage mattes, 190–193
procedural mattes, 164–166
project naming conventions, 34
Project panel
accessing items in, 11
bit-depth identifier in, 139
caching set of comps in, 117
composition setup in, 6
as file system, 103–105
locating comp in, 106
proxy appearance in, 120
revealing date column in, 13
workspace setup, 3–4
Project script, 296
Project Settings, 15
Projection, 294–296, 315–316
Propagation settings, Roto Brush, 211
proxies, 119–121
PSD file format, 21–22, 374
pt_EffectSearch, 29
pulldowns, 19
Puppet tool, 424
Purview, 210
push functions, 272, 292–293
pyrotechnicians, 447
pyrotechnics
energy effects, 439–443
explosions, 450–452
fire, 446–450
firearms, 434–439
heat distortion, 443–446
light sabers, 439–443
understanding, 434

Q
quality
of composites, 22–24
of image, 353
of light, 383
quantization, 139
QuickTime
color management in, 375
embedded timecode in, 16
working with, 11

R
Radial Blur, 61, 316
radioactive isotypes, 357
radiometrically linear color data, 366
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Radius, light falloff setting, 385
rain. See precipitation
RAM Preview, 7–8, 27, 332
RAM requirements, 113–115
Ramp effect
creating blur map with, 303–305
for gradient backgrounds, 27
Gradient Ramp effect, 414
in grain management, 308
Ramp gradient, 135–136, 414
random distribution, 339
random( ) function, 338–339
random time, expressions for,
338–339
randomness
expressions for, 335–336
random distribution, 339
random time, 338–339
wiggle time, 337–338
raster images, 75–76, 79
Raw tracks, 252
ray-traced 3D animations
blending modes and, 109
caching set of comps and, 116
information on extruded, 279
projecting image onto extruded
shape, 296
Reconstruction brush, in Liquify, 424
red, blue, green. See RGB (red, green,
blue)
red, blue, green, alpha. See RGBA
(red, blue, green, and alpha)
RED Camera, 197, 244, 353
red channel. See also RGB (red, green,
blue)
for color matching, 135–136
color-matching in dramatic
lighting, 154–157
color-matching in ordinary
lighting, 151–153
color-matching with no clear
reference, 157–158
Red Giant Software
color finishing with, 386
Colorista by, 162
Corner Pin effect by, 262
Looks by, 162
Primatte keyer by, 201
Warp by, 403
Redifinery’s Merge Projects, 14
Reel Smart Motion Blur, 62
Refine Edge
in Keylight, 186
in Roto Brush, 205–206, 210–214
Refine Edge Matte effect, 212
Refine Matte, 179, 306
Refine Soft Matte effect, 185–190
refining mattes
in color keying, 174–176
in Keylight, 181
in rotoscoping, 218–221

reflected light, 399
Region of Interest (ROI), 23–24, 181,
308
relative time, vs. absolute, 62–63
Reload Footage, 11
RE:Map plug-in, 405
Remove Color Matting effect, 83–84
Remove Grain tool, 310–311
Remove Unused Footage, 12, 14
Render, Email, Save, and Shutdown,
121
render pipelines, 113
Render Queue
creating proxies, 120
keyboard shortcuts for, 30
nested compositions in, 64
post-render options in, 119
processing power used in, 121
rendering multiple frames
simultaneously in, 35–36
settings for, 30–33
Straight vs. Multiplied Alpha
in, 82
tear away and toggling, 7
renders
with adjustment layers, 110
background, 121–123
composition in Media Encoder,
26
Freeze button for completed
mattes, 214
multipass, 404–409
of multiple frames
simultaneously, 25–26, 123
naming conventions for, 34
optimizing speed of, 118
post-render options, 119
proxies and pre-renders, 119–121
sharing data in Cinema 4D,
283–284
speeding up, 113–118
tuning in multiprocessing, 25–26
Repeat Edge Pixels, 396
Repeat values, 87
Replace Footage, 11
Reset Levels, 132
resetting effects, 132, 135–136
resolution
accuracy of Roto Brush with
full, 207
advanced composition settings
for, 110
lowest in widescreen images, 317
maximizing screen, 9
preserving when nested, 110
of shadow maps, 295
responsiveness, 24–26
Result tab, SpeedGrade, 387
retiming
absolute vs. relative time in, 62
Freeze Frame for, 65

Index
nested compositions for, 64
Time Remap for, 64–65
Time Stretch for, 63–64
Timewarp for, 65–69
Return of the Jedi, 160
Reverse Lens Distortion, 276
reverse stabilization, 246–247
ReverseMaskPath, 90
RE:Vision Effects, 161
RGB (red, green, blue)
color management and, 373–377
in Curves, 139–145
in dramatic lighting, 153–157
histograms, 138–139
Hue/Saturation in, 146
in Keylight color values, 179–180
in Levels, 136–139
in ordinary lighting, 151–153
of video images on computers,
182
RGB Straight, 83
RGBA (red, blue, green, and alpha),
347
rgbToHsl ( ), 347
rig removal, 226
right-clicking, 11
ROI (Region of Interest) tool, 23–24,
181, 308
rolling shutter artifacts, 243–244
Rolling Shutter Removal, 313
Rolling Shutter Repair, 243
Rolling Shutter Ripple, 243
Rosco colors, 181
rotation, 252
Roto Brush
3D Camera Tracker and, 234–235
add Refine Edge in, 210–214
depth maps with, 415
fixing blur map edges with, 306
foreground mattes with, 66
guidelines for, 205–206
Linear Color Key vs., 166
overview of, 75
working with, 206–210
rotoscoping
articulated mattes in, 214–218
creating masks with, 74
for depth cues, 414–415
fixing blur map with, 306
guidelines for, 204–205
introduction to, 204
Mask Feather tool in, 218–220
Motion Blur and, 218–219
organic shapes, 206–209
Paint for. See Paint
procedural matte generation vs.,
164–166
procedural mattes vs., 164–166
Refine Edge, 205–206, 210–214
Roto Brush for. See Roto Brush
rotobezier shapes, 217–218

summary of, 227
tracking mask in, 220–221
translating mask in, 220–221
Roving keyframes, 51
RPF files, 407
RPF sequences, 263

S
S-curve adjustments, 144–145
sampleImage ( ), 347
Samples Per Frame, Motion Blur, 59
sampling, color, 346–347
Sandison, Michael, 322
SanityCheck, 375
saturation. See Hue/Saturation
saving options, advanced, 14–15
scale
in cloning, 225
in grain, 311
limitations of fire, 446
in Refine Edge brush, 211
in Roto Brush, 207
tracking of, 252
in Warp Stabilizer VFX, 238–241
in wispy smoke, mist, or fog, 419
SCARLET cameras, 369
scattering of light, 399–401
scene-referred values, 361
Scott, Michael (Dorkman), 440
Screen Balance setting, 180–181
Screen blending mode, 93–94
Screen Color, 173–174, 177
Screen Gain, 180
screen mattes. See Keylight
Screen Pre-blur, 183
Screen Softness, 183
Screen transfer mode, 365–366
screens
maximizing, 9
Ram preview options, 27
Second Amendment, 435
secondary animation, 425
secondary layers, in SpeedGrade, 392
seedRandom( ) function, 338–339
segmentation boundaries, 207–208
selections
Add blending mode for, 92–94
alpha channels in, 74
Bezier masks, 86
bitmap alpha, 78–79
blending modes for, 76, 92–97
Color blending modes for, 95
combined techniques for, 77
combining layers of, 72–77
compositing with, 72
Difference blending mode for, 95
edges of, 78–84
effects for, 77
feathered alpha edges in, 78–79
HSB bending modes for, 95
Light blending modes for, 94

Luminescent Premultiply for,
96–97
masks for. See masks
mattes, 73
Multiply blending mode for, 94
opacity of, 80
Overlay blending mode for, 94
premultiplication of, 81–84
Preserve Underlying
Transparency for, 95–96
Screen blending mode for, 94
Shape tools/layers for, 87
Silhouette blending mode for, 95
Stencil blending mode for, 95
summary of, 99
track mattes for, 97–99
transparency of, 81–84
sensor sizes, 274
Separate RGB effect, 316
separating XYZ, 185
Set Focus Distance to Layer, 279
Set Matte, 98
Set Proxy, 119
Shadow Catcher, 232, 403
shadows
banding in, 352
in billowing smoke, 422
in color keying, 185
light in, 199, 383–384, 401–404
Shape layers, 84, 87–88
Shape tools, 87–88
shape tracking, 262
sharing selections with track mattes,
97–99
sharpening, for increased grain, 312
Shatter effect, 452
shells, gunshot, 435, 437
Shift Channels, 193, 308, 316
Shift+RAM Preview, 23, 27
Shortcuts file, 124
Show Cache Indicators, 115
Show Channel, 29, 135–136
Show Grid, 28
Show Properties, 43
Show Reference Graph, 44–45
Show Rulers, 28
Show Transform Box, 48–49
Shutter Angle, 59–61, 272
Shutter Phase, 59–60
shutter speed, 244, 254–255
shy layers, 38
Silhouette
Alpha blending mode, 396
blending modes, 95
rotoscoping with, 226
silver halide crystals, 357
Simple Choker, 168, 178, 191–192
Simple Wire Removal tool, 226
Single Frame Duration setting, Paint,
227
single-node camera, 291

467

Index
Skip Existing Files, 31
sky replacement
bluescreens vs., 417
infinite depth in, 417
overview of, 416–417
for storms, 428–429
slamming gamma, 161–162
Slider Control, 343
slippage, solving track, 261–262
Slope and Mirror Blend controls, 226
Slope control, 226
smoke. See also fire
billowing, 422–424
from bullet-hits, 437–438
creating, 419–421
distorting, 423
for fire, 448
from firearms, 436–437
moving through wispy, 421–422
showing color of, 413
swirling with Liquify, 424
trails, 426–427
Smoky Flyover features, 421–422
Smooth Falloff, 385
smoothing
in Refine Edge brush, 212
in Timewarp, 67
in Warp Stabilizer VFX, 240–241
Snap button, 48
snow. See precipitation
The Social Network, 304
soft (diffuse) light, 383
solo layers, 37–38
source elements, 3–4
source formats, 20–21
source layer, 237–239
source of composites, 8–11
space management, 107–108
SpeedGrade
black and white, 393–394
color management with, 374–375
day for night, 394–395
getting into, 387
grading shots in, 389–391
LUTs and, 377–379
masks in, 391–392
popular grades of, 392–395
presets in, 391
for primary color correction, 319
requirements, 387
secondaries in, 391–392
UI for, 387–388
spill suppression, 184–185, 196
Spill Suppressor effect, 178–179
Spline tool, 419
spot light meter, 198
spreading mattes, 193
Spy Kids 3-D, 94
squibs, bullet, 438
sRGB, 374, 376–377
SSD boot drive, 116
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stabilization
point, 247–248
reverse, 246–247
shooting for, 244
of shots, 237–238
when result is worse, 242–243
Stabilize Motion, in Tracker panel,
250
Stabilize Motion, Warp Stabilizer VFX,
237–238
Stabilize tracks, in Tracker panel, 251
Standard workspace, 4
Star Wars, 440–443
Status view, 173–175
Stencil Alpha blending mode, 192,
396
Stencil blending mode, 95
stock footage, for fires, Compound
Blur
storms. See precipitation
Stretch value, Time Stretch, 63–64
strobe animation, 334
Subspace Warp, 242–243, 248, 286
Subtract mode, 88–89
swiping, with Roto Brush, 207
Sync Settings, 32, 125–126
Synthesis Edges, 241–242
Synthesis Range, 242
SynthEyes, 315

T
television
29.97 fps for reality, 316–317
color and, 386
HID formats for, 317–318
PAL, 183
using Cinema 4D for
commercials, 285
templates, 103–104, 119
text, default expressions
highlighting, 324–325
three-way color correctors, 319–320
Throttle-n-Purge, 126
TIFF file format, 4, 20–21, 374
tilde (~) keyboard shortcut, 7, 9
tilt-shift lens effect, 304–305
time
absolute vs. relative, 62
delays in, 329–330
management of, 107–108
navigation of, in Timeline, 39
random, 338–339
Time Remap, 64–65, 335–336
Time Sampling, 30–31
Time Stretch, 37, 63–64
timecodes, 16
Timeline panel
absolute vs. relative time in, 62
anchor point in, 56–57
color commentary in, 37–38
column views in, 36–37

composition setup in, 6
content-clicks on layer in, 11
copy and paste animations in,
50–51
deactivating Live Update in, 24
frame blend in, 63–64
Graph Editor in, 42–50
keyboard shortcuts in, 39–42,
52–56
keyframes in, 42–50, 55
layer bar mode vs. Graph Editor,
51–52
Layer menu in, 11
layers in, 39–41
managing multiple comps from,
105–106
motion blur in, 58–62
navigation in, 39–41, 54
nested compositions in, 64
parent hierarchy in, 57–58
summary of, 69–70
time display in, 329
time navigation in, 39
Time Remap in, 64–69
time stretch in, 63–64
Timewarp in, 65–69
understanding, 36
views in, 41
working with Roto Brush in, 209
timetoFrames( ), 38
Timewarp, 65–69
Tinderbox, 399
tint, 135, 393, 428–429
Title/Action Safe, 28
toComp( ) expression, 341–342
Toggle Mask, 29
Toy Story 3, 404
Track Camera, 231
Track in mocha AE, 257, 260
track mattes
render pipeline rules for, 113
for sharing selections, 97–99
for undoing strong keylight, 384
track points
in 3D Camera Tracker, 232–233
in Cinema 4D Lite, 287
in isolation of object/plane,
244–245
in reverse stabilization, 246–247
in Warp Stabilizer VFX, 244–245
Tracker panel, 249–251
Tracker2Mask, 256
TrackerViz, 220, 255
tracking
masks, 220–221
motion. See motion tracking
Trajectory script, 314
transform boxes, 48–49
Transform controls, in Timeline, 42,
56
Transform effect, 308

Index
Transform tracks, in Tracker panel,
251
transforms, layer space, 340–346
translating masks, 220–221
transparency
with blending modes, 92–97
with compositing formula, 78
with layers, 72–77
with mask modes/combinations,
88–91
with masks, 84–88
with opacity, 80
optics and, 78–80
with premultiplication, 81–84
sharing selections with track
mattes, 97–99
working with, 81
Trapcode
Lux effect, 397, 399, 401
Particular. See Particular
Shine, 400–401
Tripod Pan Shots, 234
True Comp Duplicator, 107
Truffaut, Francois, 394
Tuning section, in Timewarp, 67
Turbulence brush, 424
Turbulence Displace effect, 427
Turbulent Noise effect, 419–421,
436–437
Tweaking controls, Match Grain,
308–309
Twilight Zone, 316
two-node camera, 291, 299–301

U
überkey, defined, 53
Unified Camera tool, 291
unsolvable shots, in 3D Camera
Tracker, 235–236
Used spyglass, 12
user interfaces (UIs)
for composites, 4, 22–29
in Curves control, 140
in SpeedGrade, 387–388

V
Vanilla Sky, 416
variables, JavaScript, 330
Vector Detail, 67
vector shapes
brushes based on, 222
masks as hand-drawn, 74–76, 84
versions, of Cinema 4D, 280–281
vibrance, 302
video
adjustments in linear space vs.
native, 363–366
gamma space of, 360–361
HDR images in, 367
not sharing between Photoshop/
After Effects, 21

View Edge Region, Refine Soft
Matte, 188
View LUT, 112
View menu, 56–57, 225
View Options, 29
views
column, 36–37
Flowchart, 53
of LUTs, 378–379
in Preview panel, 27
in Timeline panel, 41
vignettes, 313, 315
Vivid Light blending mode, 94
volumetric light, 399–401

W
Warp brush, 424
Warp Layer, in Timewarp, 67
Warp Stabilizer VFX
advanced options in, 243
Auto-Scale in, 240–242
Crop in, 241
eliminate warping in, 242
inability to fix motion blur in, 243
isolating object or plane in,
245–246
locking shot in, 239
new features in, 236–237
point stabilization in, 247–248
reverse stabilization in, 246–247
shooting for stabilization in, 244
Smoothness adjustments in,
240–241
stabilizing shot in, 237–239
Synthesize Edges in, 241–242
warping, eliminating in Warp
Stabilizer VFX, 242
Watch Folder, 123
weighting, 69, 393–394
Welles, Orson, 297
wet look, 427–430
What Dreams May Come movie, 231
white
in bitmaps, 78
contrast adjustments, 130–133
in depth maps, 303
in dramatic lighting, 153–157
in Extract, 167
hex color values for, 373
on monitors, 91, 355
with no clear reference, 157–158
as opacity in mattes, 73
in ordinary lighting, 150, 152–153
output. See Output Black/Output
White
pixel values in, 73, 91–92
in Screen mode, 92
using SpeedGrade for, 393–394
widescreen formats, 317–318
wiggle( ) expressions, 337–338
wind, 425–427

Wing menu, 153
wire removal, 226
Working Space setting, 376
workspaces
resetting to customized
version, 8
setting linearized, 361–363
setting up, 3–5
world space, coordinate system
for, 340
wrapping, light, 395, 396–397
Write On setting, Paint menu, 223

X
X Position keyframes, 46–48
X Rotation, 278, 429
X-spline tool, 258, 262

Y
Y axis, in 3D, 292
Y Position keyframes, 46–48
YCrCb, video images in, 182
YUV, 182–183

Z
Z Position keyframes, 46–48
ZBornToy, 407
Zeno’s paradox, 80
zoom functions
in 3D Camera Tracker, 232, 264
in cameras, 272, 292–296
flares, 398
keyboard shortcut for, 24
Zorro, 38
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